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●BIỆN PHÁP AN TOÀN●
(Luôn luôn đọc hướng dẫn này trước khi sử dụng sản phẩm.)

Trước khi thiết kế một hệ thống, hãy đảm bảo đọc kỹ các sách hướng dẫn sử dụng liên quan và 
sử dụng sản phẩm đúng cách với sự chú ý cao độ về an toàn.

[BIỆN PHÁP PHÒNG NGỪA KHI THỰC TẬP CÓ TRONG TÀI LIỆU NÀY]

CẢNH BÁO
• Khi nguồn điện đang mở, không chạm vào đầu nối điện để tránh gây ra bất kỳ tai 

nạn điện giật nào.

• Trước khi mở nắp an toàn, ngắt điện hệ thống hoặc đặt trong môi trường an toàn.

CHÚ Ý
• Khi cài đặt hoặc gỡ bỏ mô đun hay các khối thiết bị, trước hết hãy ngắt nguồn điện.  

Làm như vậy khi nguồn điện đang mở có thể gây hư hại mô đun hay khối thiết bị 
hoặc gây ra điện giật.

• Khi có bất kỳ lỗi hoặc sự cố nào xảy ra, lập tức dừng sử dụng mô đun hoặc thiết bị.

[HƯỚNG DẪN SỬ DỤNG LIÊN QUAN GOT2000]

Về thông tin chi tiết, vui lòng tham khảo từng hướng dẫn sử dụng của GOT2000.

Nếu bạn cần bản in của hướng dẫn sử dụng, hãy tham khảo ý kiến của văn phòng đại 

diện hoặc chi nhánh Mitsubishi tại địa phương của bạn.

* Tài liệu này sử dụng GT Designer3 (GOT2000) Version1.153K cho phần giải thích

Tuỳ thuộc vào phiên bản được sử dụng, mà hiển thị của menu và màn hình có thể 

khác nhau.



ĐẶC ĐIỂM CỦA GOT                                                                                                                                           1

Giao diện và hình dáng bên ngoài của GOT                                                                                                2

CHUẨN BỊ CÁC THIẾT BỊ ĐƯỢC YÊU CẦU                                                                                                             3

CÁC THIẾT BỊ ĐƯỢC YÊU CẦU ĐỂ VẬN HÀNH GOT                                                                                       3

ĐẶC ĐIỂM CỦA GT Designer3                                                                                                                             4

BỐ CỤC MÀN HÌNH CỦA GT Designer3                                                                                                       5

CÁC MÀN HÌNH CÓ THỂ TẠO ĐƯỢC BẰNG GT Designer3                                                                            6

BƯỚC 1 TẠO MỘT PROJECT 1-1

1 1 TẠO MỘT PROJECT MỚI                                                                                                                            1-2

1 2 TẠO MỘT ĐỐI TƯỢNG                                                                                                                               1-9

1 2 1 Tạo một Công tắc RUN                                                                                                                   1-9

1 2 2 Tạo một Công tắc STOP                                                                                                                 1-13

1 2 3 Tạo một đèn báo hiệu đang vận hành                                                                                          1-16

1 2 4 Tạo một hiển thị ộ số                                                                                                                    1-21

1 3 TẠO MỘT HÌNH                                                                                                                                       1-23

1 3 1 Tạo một hình (Hình chữ nhật)                                                                                                       1-23

1 3 2 Tạo các hình (Văn bản) từ 1 tới 3                                                                                                   1-25

1 3 3 Tạo các hình (Văn bản) 4 và 5                                                                                                        1-28

1 4 CÀI ĐẶT CHỨC NĂNG CHẠM VUỐT MÀN HÌNH                                                                                       1-29

1 5 KIỂM TRA MÀN HÌNH ĐÃ TẠO                                                                                                                 1-33

1 5 1 Kiểm tra hiển thị (Xem trước màn hình)                                                                                        1-33

1 5 2 Kiểm tra lỗi dữ liệu (Kiểm tra dữ liệu)                                                                                            1-36

1 5 3 Kiểm tra vận hành (Bộ giả lập)                                                                                                      1-37

1 6 LƯU PROJECT                                                                                                                                         1-41

BƯỚC 2 TRUYỀN DỮ LIỆU PROJECT 2-1

2 1 TRUYỀN DỮ LIỆU PROJECT                                                                                                                       2-2

2 1 1 Kết nối máy tính cá nhân với GOT                                                                                                   2-2

2 1 2 Thiết lập giao tiếp                                                                                                                           2-3

2 1 3 Truyền dữ liệu project                                                                                                                     2-4

2 2 KẾT NỐI GOT VÀ PLC                                                                                                                                2-6

2 2 1 Kết nối GOT và PLC                                                                                                                        2-6

2 2 2 Kiểm tra trạng thái kết nối                                                                                                             2-7

2 2 3 Ghi chương trình tuần tự vào PLC                                                                                                   2-9

NỘI DUNG



1

2

3

4

PHỤ LỤC

BƯỚC 3 SỬ DỤNG GOT 3-1

3 1 KIỂM TRA HOẠT ĐỘNG BẬT/TẮT CỦA CÁC CÔNG TẮC                                                                               3-2

3 2 SỬ DỤNG CHỨC NĂNG CHẠM VUỐT MÀN HÌNH                                                                                       3-4

3 3 DANH SÁCH CÁC CHỨC NĂNG GOT                                                                                                         3-6

3 4 Chức năng thuận tiện cho việc bảo trì                                                                                                    3-10

BƯỚC 4 BẢO TRÌ GOT 4-1

4 1 SỰ CẦN THIẾT CỦA VIỆC BẢO TRÌ                                                                                                              4-2

4 2 SAO LƯU                                                                                                                                                   4-3

4 2 1 Sao lưu dữ liệu GOT                                                                                                                        4-5

4 2 2 Sao lưu dữ liệu trong các thiết bị kết nối                                                                                      4-10

4 3 BÁO ĐỘNG                                                                                                                                             4-18

4 3 1 Kiểm tra báo động hệ thống                                                                                                         4-19

4 4 PIN                                                                                                                                                         4-21

4 4 1 Lắp pin                                                                                                                                         4-21

4 4 2 Tháo pin                                                                                                                                       4-25

4 4 3 Kiểm tra điện áp pin                                                                                                                     4-28

PHỤ LỤC  PHỤ LỤC 1-1

PHỤ LỤC 1 CÁC MÃ LỖI VÀ DANH SÁCH BÁO ĐỘNG HỆ THỐNG                                                    PHỤ LỤC 1-1

PHỤ LỤC 2 CÀI ĐẶT VÀ THÁO                                                                                                         PHỤ LỤC 2-1

1 Biện pháp phòng ngừa khi cài đặt                                                                                        PHỤ LỤC 2-1

2 Cắt bảng pa nen                                                                                                                   PHỤ LỤC 2-1

3 Vị trí cài đặt                                                                                                                           PHỤ LỤC 2-3

4 Nhiệt độ bên trong bảng điều khiển và Góc cài đặt GOT                                                     PHỤ LỤC 2-6

5 Cài đặt GOT                                                                                                                          PHỤ LỤC 2-7

6 Tháo GOT                                                                                                                             PHỤ LỤC 2-8

7 Lắp/Tháo thẻ SD                                                                                                                   PHỤ LỤC 2-9

8 Đấu dây cung cấp điện cho GOT                                                                                        PHỤ LỤC 2-11

PHỤ LỤC 3 HIỆU CHỈNH MÀN HÌNH CẢM ỨNG                                                                                PHỤ LỤC 3-1

PHỤ LỤC 4 SÁCH HƯỚNG DẪN SỬ DỤNG VÀ CATALÔ CÓ LIÊN QUAN                                            PHỤ LỤC 4-1

PHỤ LỤC 5 LẮP RÁP THIẾT BỊ THỰC TẬP                                                                                          PHỤ LỤC 5-1



1

GOT là tên viết tắt của “Graphic Operation Terminal”.

Công tắc và đèn được gắn vào bảng điều khiển giống như phần cứng của máy. Tuy nhiên, bằng việc sử dụng phần mềm 
thiết kế màn hình, chúng có thể được tạo ra, hiển thị, và thao tác trên màn hình giám sát của GOT, HMI dạng bảng cảm 
ứng.

Tiết kiệm 
không gian

GOT

Giảm 
chi phí

Bảng điều khiển 
thường

ƯU ĐIỂM CỦA GOT
(1) Giảm kích thước bảng điều khiển

Do công tắc và đèn được tạo ra bằng cách sử dụng phần mềm, nên số linh kiện được gắn vào bảng điều khiển như 
phần cứng có thể được giảm bớt và bảng điều khiển có thể giảm được kích thước.

(2) Giảm chi phí đấu dây
Đấu dây giữa các linh kiện bên trong bảng điều khiển được thay thế bởi thiết kế màn hình bằng phần mềm, loại bỏ 
được nhu cầu đấu dây tốn nhiều thời gian và chi phí lớn.

(3) Tiêu chuẩn hoá các bảng điều khiển
Cho dù bạn có được yêu cầu thay đổi thông số kỹ thuật, bạn cũng chỉ cần thay đổi thiết lập bằng cách sử dụng 
phần mềm.
Bởi thế, các bảng điều khiển có thể được tiêu chuẩn hoá.

(4) Thêm giá trị phụ giống như HMI (Human Machine Interface)
Ngoài công tắc và đèn, GOT có thể dễ dàng hiển thị đồ hoạ, văn bản, và chuông báo động.
Bởi thế, bạn có thể cải thiện giá trị phụ của toàn bộ các thiết bị.

ĐẶC ĐIỂM CỦA GOT
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Giao diện và hình dáng bên ngoài của GOT
Dưới đây là hình dáng bên ngoài của GOT2000 và.

[Mặt trước]

* GT27 (chỉ 15-inch và 12,1-inch)

GOT phát hiện người vận hành và 
hiển thị màn hình tự động. 
Khi không có ai xung quanh, 
đèn nền sẽ tắt để 
tiết kiệm năng lượng.

Thiết kế đơn giản và hợp thời 
trang với mô típ đẹp và bổ sung 
thiết kế máy bất kỳ.

Có thể truyền dữ liệu mà không 
cần mở vỏ máy.

Vòng đời dài sẽ giảm thiểu 
chi phí bảo trì và thay thế. 

Có thể truyền dữ liệu màn hình 
và có thể gọi ra dữ liệu trong GOT 
bằng cách sử dụng bộ nhớ USB. 
Kết nối một chuột USB 
và bàn phím.

Cảm biến tiệm cận Thiết kế đơn giản

Đèn nền LED

Thiết bị USB

Máy chủ USB

* Thiết bị USB nằm trên mặt sau đối với mẫu 
trắng và GT21.

* Chỉ với GT27 và GT25. Cổng kết nối USB nằm 
trên mặt sau đối với mẫu trắng.

[Mặt sau]

Giao diện mở rộng

Ethernet

RS-422/485

Khe cắm thẻ SD

Có thể gắn truyền thông và 
các đơn vị tùy chọn.

Kết nối thiết bị FA khác, đầu 
đọc mã vạch, máy in nối tiếp 
có thể được kết nối.

Có thể lưu một số lượng lớn dữ liệu 
bao gồm dữ liệu báo động dữ liệu 
lưu trữ.

Có thể kết nối thiết bị FA 
khác nhau.

Có đến 4 loại PLC từ các nhà sản 
xuất khác nhau* có thể được kết 
nối đồng thời bằng Ethernet.

Cổng kết nối USB

Thiết bị lưu trữ bộ nhớ chuẩn USB 
có thể được gắn vào để lưu dữ liệu 
báo động và dữ liệu ghi lại.
Kết nối chuột và bàn phím hỗ trợ 
chuẩn USB.

RS-232

* Chỉ với GT27 và GT25

* Ảnh này là GT2712. * Chỉ với GT27 và GT25

Cổng mini USB type B

Có thể kết nối GOT 
với máy tính cá nhân 
để truyền dữ liệu.
* Chỉ mẫu trắng

* Có đến 2 loại PLC dành cho GT21



3

CHUẨN BỊ CÁC THIẾT BỊ ĐƯỢC YÊU CẦU
CÁC THIẾT BỊ ĐƯỢC YÊU CẦU ĐỂ VẬN HÀNH GOT

Để vận hành GOT, cần phải có GOT ( 1 ), dây cáp ( 2 ), máy tính cá nhân và phần mềm ( 3 ), và bộ điều khiển ( 4 ).

GOT2000 (GT27)

Cáp USB 
(GT09-C30USB-5P)

Cáp Ethernet

PLC 

GOT Cáp Máy tính cá nhân và phần mềm

Bộ điều khiển

2 3

4

Máy tính cá nhân

Phần hỗ trợ GT Designer3 (GOT2000) 
GT Designer3 (GOT2000)

GX Works3

1

Tham khảo

Về cách cài đặt phần mềm thiết kế màn hình, vui lòng tham khảo hướng dẫn sau.

 ● GT Works3 Installation Instructions BCN-P5999-0066/0071

Về phương pháp kết nối GOT và bộ điều khiển, vui lòng tham khảo hướng dẫn sau.

 ● GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1 SH-081197ENG
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GT Designer3 là phần mềm dùng để tạo ra màn hình cho sê-ri GOT2000 và sê-ri GOT1000.
Phần mềm này cho phép bạn tạo chỉnh sửa một project, và truyền dữ liệu giữa GOT và máy tính cá nhân.

Giả lập 

tạo project

Máy tính cá nhân (GT Designer3)

Truyền dữ liệu

GOT

GT Designer3 bao gồm các phần mềm thiết kế màn hình sau.
 ● GT Designer3 (GOT2000): Phần mềm thiết kế màn hình cho sê-ri GOT2000

 ● GT Designer3 (GOT1000): Phần mềm thiết kế màn hình cho sê-ri GOT1000

Tài liệu này mô tả việc tạo một màn hình cho GOT2000 bằng GT Designer3 (GOT2000).

Hình ảnh màn hình của GT Designer3 (GOT2000)

ĐẶC ĐIỂM CỦA GT Designer3
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BỐ CỤC MÀN HÌNH CỦA GT Designer3

Dưới đây là bố cục màn hình của GT Designer3.
1

2

3

4

5

6

7

8
3

4

3

1  Title bar (Thanh tiêu đề)
Hiển thị tên phần mềm, tên project, và tên tập tin.

2  Menu bar (Thanh menu)
Có thể thao tác GT Designer3 từ menu kéo xuống.

3  Toolbar (Thanh công cụ)
Có thể thao tác GT Designer3 bằng các nút. Bạn có thể đặt thanh công cụ ở bên trái, bên phải, phía trên, hoặc phía dưới.

4  Docking window (Cửa sổ treo)
Các cửa sổ windows có thể được treo bằng màn hình của GT Designer3.

5  Editor tab (Tab chỉnh sửa)
Hiển thị các tab của cửa sổ windows và trình biên tập màn hình trên cửa sổ làm việc.

6  Work window (Cửa sổ làm việc)
Hiển thị trình biên tập màn hình, cửa sổ [Environmental Setting], cửa sổ [GOT Setup], và các cửa sổ windows khác.

7  Screen editor (Trình biên tập màn hình)
Tạo màn hình để hiển thị trên GOT bằng cách đặt hình và đối tượng trên trình biên tập màn hình.

8  Status bar (Thanh trạng thái)
Hiển thị thông tin theo như vị trí con trỏ chuột, trạng thái của hình hoặc đối tượng được chọn.
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(a) Cửa sổ đặt lên trên

(c) Cửa sổ bàn phím
(d) Cửa sổ hộp thoại

(b) Cửa sổ chồng chéo

Các màn hình đã tạo với GT Designer3 Màn hình đã hiển thị trên GOT

348BA1254

Màn hình trạng thái sản xuất 1

Màn hình nền

348BA1254

Màn hình trạng thái sản xuất 1

Màn hình nền

Màn hình cửa sổ

(1) Màn hình nền
Là màn hình mà được hiển thị như màn hình nền của GOT.
Thiết bị chuyển đổi màn hình điều khiển sự hiển thị của màn hình nền.

(2) Màn hình cửa sổ
Là một màn hình hiển thị như cửa sổ chồng chéo, cửa sổ đặt lên trên, cửa sổ bàn phím, và cửa sổ hộp thoại trên 
GOT.

(a) Cửa sổ đặt lên trên
Là cửa sổ được đặt lên trên màn hình nền và hiển thị như một bộ phận của màn hình nền.
Có thể hiển thị cùng lúc lên đến hai cửa sổ đặt lên trên (cửa sổ đặt lên trên 1 và 2).
Thiết bị chuyển đổi màn hình điều khiển sự hiển thị của màn hình cửa sổ.

(b) Cửa sổ chồng chéo
Là cửa sổ nhảy ra hiển thị chồng lên màn hình nền.
Có thể hiển thị cùng lúc lên đến năm cửa sổ chồng chéo (cửa sổ chồng chéo 1 đến 5).
Có thể di chuyển vị trí hiển thị của cửa sổ chồng chéo bằng thao tác chạm hoặc thiết bị chỉ định vị trí hiển thị.
Thiết bị chuyển đổi màn hình điều khiển sự hiển thị của màn hình cửa sổ.
(GT21 có thể hiển thị cùng lúc lên đến hai cửa sổ chồng chéo (cửa sổ chồng chéo 1 và 2).)

(c) Cửa sổ bàn phím
Là cửa sổ nhảy ra hiển thị trên màn hình nền cho phép nhập giá trị và những chức năng khác.
Có thể di chuyển vị trí hiển thị của cửa sổ bàn phím bằng thao tác chạm.
Có hai loại Cửa sổ bàn phím được cung cấp: Cửa sổ bàn phím tiêu chuẩn GOT và Cửa sổ bàn phím người dùng 
tạo.

(d) Cửa sổ hộp thoại
Là cửa sổ hiển thị thông báo lỗi, thông báo cảnh báo, và thông báo hệ thống GOT trên mặt trước.
Trong khi cửa sổ hộp thoại đang được hiển thị, không thể thao tác các màn hình khác.
Thiết bị chuyển đổi màn hình điều khiển sự hiển thị của màn hình cửa sổ.

(3) Màn hình báo cáo
Là cửa sổ xuất dữ liệu bằng chức năng báo cáo.
Màn hình này không được hiển thị trên GOT.

CÁC MÀN HÌNH CÓ THỂ TẠO ĐƯỢC BẰNG GT Designer3
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Ghi chú



1-1

1BƯỚC 1 

TẠO MỘT PROJECT



1-2

Màn hình sau đây sẽ được tạo ra trong phần này.

1 2

6

3

5

4

1 Công tắc RUN, công tắc STOP
Chạm vào từng công tắc để bật hoặc tắt biến dạng bit trong PLC.
→ 1.2.1 Tạo một Công tắc RUN
→ 1.2.2 Tạo một Công tắc STOP

2 Đèn báo hiệu đang vận hành
Bật hoặc tắt theo trạng thái của biến dạng bit trong PLC.
→ 1.2.3 Tạo một đèn báo hiệu đang vận hành

3 Hiển thị số
Hiển thị giá trị được lưu trữ trong PLC.
→ 1.2.4 Tạo một hiển thị ộ số

4 Hình (Hình chữ nhật)
Đặt các hình chữ nhật để hiển thị rõ hơn các công tắc và đèn.
→ 1.3.1 Tạo một hình (Hình chữ nhật)

5 Hình (Văn bản) từ 1 tới 5
Hiển thị các ký tự mô tả màn hình, các công tắc, và đèn.
→ 1.3.2 Tạo các hình (Văn bản) từ 1 tới 3
→ 1.3.3 Tạo các hình (Văn bản) 4 và 5

6 Công tắc chạm vuốt màn hình
Khép 2 ngón tay vào để thu nhỏ màn hình và mở 2 ngón tay ra để phóng to màn hình bằng công tắc này.
→ 1.4 CÀI ĐẶT CHỨC NĂNG CHẠM VUỐT MÀN HÌNH

1.1 TẠO MỘT PROJECT MỚI
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1

(1) Tạo một project mới
Khởi động GT Designer3(GOT2000) và đi theo trình hướng dẫn để thiết lập cấu hình cài đặt.

Nhấp chuột!

1

1 Chọn [MELSOFT Application] → [GT Works3] 
→ [GT Designer3] từ menu khởi động của 
Windows.

Nhấp chuột!

2
2 Nhấp chuột vào nút [New] trong hộp thoại 

Select Project.

Nhấp chuột!

3

3 Nhấp chuột vào nút [Next] trên màn hình khởi 
động của New Project Wizard.
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Gợi ý

Có thể khởi động GT Designer3 từ màn hình nền khi tạo một biểu tượng phím tắt trong lúc 

cài đặt.

Nhấp chuột!

4

4 Kiểm tra cài đặt trong cửa sổ thiết lập hệ thống 
và nhấp chuột vào nút [Next].
• Series: GOT2000

• GOT Type: GT27**-V (640×480)

• Use the gesture function: Đã chọn

• Standard Language: English

• Outline Font

Alphanumeric/Kana: Đã chọn

Kanji: Không chọn

Hangul: Không chọn

Nhấp chuột!

5

5 Kiểm tra những cài đặt đã hiển thị và nhấp 
chuột vào nút [Next].

Nhấp chuột!

7

Chọn 6

6 Chọn [MELSEC iQ-R, RnMT/NC] trong danh sách 
thả xuống của [Controller Type] trên cửa sổ 
thiết lập giao tiếp.

7 Nhấp chuột vào nút [Next].
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1

Nhấp chuột!

9

Chọn 8

8 Chọn [Standard(Ethernet):Multi] trong danh 
sách thả xuống của [I/F].

9 Nhấp chuột vào nút [Next].

Nhấp chuột!

10

10 Kiểm tra cài đặt của trình điều khiển giao tiếp 
và nhấp chuột vào nút [Detail Setting].
Communication Driver: Ethernet(MELSEC), 
Q17nNC, CRnD-700, Gateway

Nhấp chuột!

11

Nhấp chuột!

12

11 Cửa sổ như bên trái sẽ hiện ra. Thay đổi giá trị 
của [GOT Station].
GOT Station: 2

12 Nhấp chuột vào nút [OK].

Gợi ý

Nhấp chuột vào nút [GOT Standard Ethernet Setting] để thay đổi địa chỉ IP của GOT.
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Nhấp chuột!

13

13 Nhấp chuột vào nút [Next].

Nhấp chuột!

14

14 Kiểm tra những cài đặt đã hiển thị và nhấp 
chuột vào nút [Next].

Nhấp chuột!

15

15 Kiểm tra biến quản lý chuyển đổi màn hình của 
màn hình nền và nhấp chuột vào nút [Next].
Base Screen: GD100 (Default)
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1

Nhấp chuột!

16

16 Kiểm tra cài đặt với trình hướng dẫn rồi nhấp 
chuột vào nút [Finish].

Màn hình biên tập của GT Designer3(GOT2000) sẽ hiện ra, và màn hình nền 1 được tạo.
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 ■ Khi GT Designer3(GOT1000) được khởi động

GT Designer3 sẽ khởi động phần mềm thiết kế màn hình được sử dụng để lưu một project gần nhất.

Khi khởi động phần mềm thiết kế màn hình cho GOT1000

Khi GT Designer3(GOT1000) được khởi động, khởi động phần mềm thiết kế màn hình cho GOT2000 bằng một trong hai 
phương pháp sau đây.
(1) Khởi động GT Designer3(GOT2000) từ menu

Chọn [Project] → [Start GT Designer3(GOT2000)] từ thanh menu để khởi động GT Designer3(GOT2000).

(2) Khởi động GT Designer3(GOT2000) từ trình hướng dẫn
Chọn [GOT2000] cho [Series] trên hộp thoại [New Project Wizard] để khởi động GT Designer3(GOT2000).
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1

(1) Đặt một công tắc
Chọn [Object] → [Switch] → [Bit Switch] từ thanh menu để đặt một công tắc.

Gợi ý

Bạn cũng có thể chọn mục từ thanh công cụ.

Gợi ý

Đặt một đối tượng

Khi chọn một đối tượng từ menu hoặc thanh công cụ, hình dạng của con trỏ sẽ chuyển thành “+”.

Nhấp chuột vào bất kỳ vùng nào mà đối tượng được đặt trên một trình biên tập màn hình.

Nhấp chuột Đặt

Đối tượng có thể được đặt theo mọi kích thước bằng cách rê con trỏ.

Rê Đặt

(2) Cài đặt một thiết bị và hoạt động

Nhấp đôi 
chuột!

1

1 Nhấp đôi chuột vào công tắc đã đặt.

1.2 TẠO MỘT ĐỐI TƯỢNG
1.2.1 Tạo một Công tắc RUN
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Cài đặt “Device: M0” và 
“Action: Momentary”.

2

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

2 Device: M0
Action: Momentary

Điểm lưu ý

Cài đặt một biến

Nhấp chuột vào  để cài đặt một biến.

Nhấp chuột!

Điểm lưu ý

Cũng có thể cài đặt biến bằng cách nhập trực tiếp thông qua bàn phím.
Nhập trực tiếp 
một thiết bị và 
nhấn phím Enter.
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1

(3) Cài đặt nhãn

Nhấp chuột!

3

Nhập “RUN” 
vào Text.

4

Nhấp chuột!

5

3 Chọn tab Text.

4 Nhập “RUN” vào Text.

5 Nhấp chuột vào nút [OK].

Hoàn tất tạo công tắc RUN.

Tham khảo

Nếu có bất kỳ thắc mắc nào, nhấn phím F1 để khởi động phần hỗ trợ GT Designer3(GOT2000). 

Trang hỗ trợ thích hợp với hoạt động bạn đang thực hiện sẽ được hiển thị.
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 ■ Hoạt động chuyển mạch bit

Một chuyển mạch bit sẽ bật và tắt biến dạng bit được xác định bằng công tắc.
Dưới đây cho thấy các hoạt động có thể được cài đặt với chuyển mạch bit.

(1) Tức thời bit
Giữ một biến dạng bit cụ thể khi bạn chạm vào công tắc.

X0001: TẮT

STOP

X0001: TẮT

STOP

X0001: BẬT

RUN

X0001: TẮT

STOP

X0001: BẬT

RUN

(2) Luân phiên bit
Luân phiên trạng thái của một biến dạng bit cụ thể (ON←→OFF) khi bạn chạm vào công tắc.
X0001: TẮT

STOP

X0001: BẬT

RUN

X0001: BẬT

RUN

X0001: BẬT

RUN

X0001: TẮT

STOP

X0001: TẮT

STOP

(3) Bật bit
Bật một biến dạng bit cụ thể khi bạn chạm vào công tắc.
X0001: TẮT

STOP

X0001: BẬT

RUN

X0001: BẬT

RUN

X0001: BẬT

RUN

X0001: BẬT

RUN

X0001: BẬT

RUN

(4) Tắt bit
Tắt một biến dạng bit cụ thể khi bạn chạm vào công tắc.

X0001: TẮT

STOP

X0001: BẬT

RUN

X0001: TẮT

STOP

X0001: TẮT

STOP

X0001: TẮT

STOP

X0001: TẮT

STOP
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1

(1) Sao chép lại công tắc RUN

Rê công tắc 
trong lúc nhấn 
phím Ctrl. 2

Nhấp chuột!

1
1 Chọn công tắc RUN.

2 Rê công tắc trong lúc nhấn phím Ctrl.

(2) Thay đổi biến trong bản sao của công tắc RUN

Nhấp đôi 
chuột!

3

3 Nhấp đôi chuột vào công tắc RUN đã sao chép.

Thay đổi biến từ 
“M0” sang “M1”. 4

4 Khi hộp thoại như bên trái hiện lên, thay đổi 
thiết bị như sau đây.
Device: M0 → M1

1.2.2 Tạo một Công tắc STOP
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(3) Thay đổi màu đồ họa của công tắc

Nhấp chuột!

5

Nhấp chuột!

6
Nhấp chuột!

8

Thay đổi màu từ 
“Blue” sang “Red”.

7 9

5 Chọn tab Style.

6 Chọn hình dạng của trạng thái tắt.

7 Chọn màu đồ họa.
Blue → Red

8 Chọn hình dạng của trạng thái bật.

9 Chọn màu đồ họa.
Blue → Red

(4) Thay đổi văn bản của công tắc

Nhấp chuột!

10

Thay đổi văn bản 
từ “RUN” sang 
“STOP”. 11

Nhấp chuột!

12

10 Chọn tab Text.

11 Nhập “STOP” vào Text.

12 Nhấp chuột vào nút [OK].

Hoàn tất tạo công tắc STOP.
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1
 ■ Trang thuộc tính

Trang thuộc tính hiển thị danh sách của các thuộc tính và giá trị cài đặt của màn hình, hình, hoặc đối tượng đã chọn.
Có thể kiểm tra hoặc thay đổi cài đặt mà không cần mở hộp thoại cài đặt.
Có thể cùng thay đổi giá trị cài đặt bằng cách chọn nhiều hình hoặc đối tượng trên cùng màn hình.

Thay đổi các thiết bị Thay đổi màu đồ họa Thay đổi văn bản

Tham khảo

Vui lòng tham khảo việc làm thế nào để hiển thị trang thuộc tính và làm thế nào để cài đặt từng mục trong phần hỗ 

trợ hoặc GT Designer3(GOT2000) Screen Design Manual.
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(1) Đặt một đèn
Chọn [Object] → [Lamp] → [Bit Lamp] từ thanh menu để đặt một đèn.

Gợi ý

Bạn cũng có thể chọn mục từ thanh công cụ.

(2) Cài đặt một biến, hình dạng, và màu cho đèn

Nhấp đôi 
chuột!

1

1 Nhấp đôi chuột vào đèn đã đặt.

Thay đổi màu từ 
“Red” sang “Green”. 4 6

Nhấp chuột!

3

Nhấp chuột!

5

Cài đặt “Y0010”.
2

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

2 Device: Y0010

3 Chọn hình dạng của trạng thái tắt.

4 Chọn màu đồ họa.
Red → Green

5 Chọn hình dạng của trạng thái bật.

6 Chọn màu đồ họa.
Red → Green

1.2.3 Tạo một đèn báo hiệu đang vận hành
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1

(3) Cài đặt nhãn cho đèn

Nhấp chuột!

7

Chọn 
“12”. 9

Nhập 
“STOP”. 10

Nhấp chuột!

8

7 Chọn tab Text.

8 Chọn hình dạng của trạng thái tắt.

9 Text Size: Chọn 12 dot.

10 Nhập “STOP” vào Text.

Nhấp chuột!

12 Chọn 
“Black”. 13

Nhấp chuột!

11

Nhập 
“RUN”. 14

Nhấp chuột!

15

11 Xóa hộp chọn ở “OFF=ON”.

12 Chọn hình dạng của trạng thái bật.

13 Chọn blac ở Text Color.

14 Nhập “RUN” vào Text.

15 Nhấp chuột vào nút [OK].

Hoàn tất tạo đèn báo hiệu đang vận hành.
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 ■ Hiển thị của đối tượng trên trình biên tập màn hình

Hiển thị trạng thái của đối tượng trên trình biên tập màn hình và có thể chuyển đổi hiển thị hoặc không hiển thị thông 
tin cài đặt.

(1) Chuyển đổi trạng thái của đối tượng được hiển thị trên trình biên tập màn hình
(a) Chuyển đổi trạng thái giữa ON và OFF

Chọn [View] → [Switch ON/OFF Display] từ menu để chuyển đổi giữa hình ảnh của trạng thái bật và hình ảnh 
của trạng thái tắt của từng đối tượng trên trình biên tập màn hình.
Nếu cài đặt một trạng thái cho một đối tượng, hiển thị của đối tượng sẽ chuyển đổi giữa OFF với trạng thái Số 0 
và ON với trạng thái Số 1.

(b) Chuyển đổi trạng thái bằng cách xác định một trạng thái Số.
Chọn [View] → [State No.] → [Previous State] hoặc [Next State] từ menu để thay đổi hiển thị của đối tượng trên 
trình biên tập màn hình theo Số trạng thái.
Nếu chuyển đổi trạng thái của một đối tượng giữa ON và OFF, hiển thị của đối tượng sẽ chuyển đổi giữa OFF với 
trạng thái Số 0 và ON với trạng thái Số 1 hoặc hơn.

Trạng thái Số 0 Trạng thái Số 1 Trạng thái Số 63

•••

(2) Cài đặt thông tin muốn hiển thị trên trình biên tập màn hình
(a) Biến

Chọn [View] → [Display Items] → [Device] từ menu để chuyển đổi giữa việc hiển thị và ẩn thiết bị trên trình 
biên tập màn hình.

(b) Biến nhãn hệ thống
Chọn [View] → [Display Items] → [Device of System Label] từ menu để chuyển đổi giữa việc hiển thị và ẩn biến 
được gán cho nhãn hệ thống trên trình biên tập màn hình.
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1

(c) ID đối tượng
Chọn [View] → [Display Items] → [Object ID] từ menu để chuyển đổi giữa việc hiển thị và ẩn các ID đối tượng 
trên trình biên tập màn hình.

(d) Màu
Chọn [View] → [Display Items] → [Paint] từ menu để chuyển đổi giữa việc hiển thị và ẩn tô màu trên trình biên 
tập màn hình.

(e) Đối tượng
Chọn [View] → [Display Items] → [Object] từ menu để chuyển đổi giữa việc hiển thị và ẩn các đối tượng trên 
trình biên tập màn hình.

(f ) Khung đối tượng
Chọn [View] → [Display Items] → [Object Frame] từ menu để chuyển đổi giữa việc hiển thị và ẩn các khung đối 
tượng trên trình biên tập màn hình.

(g) Thông tin mẫu
Chọn [View] → [Display Items] → [Template Information] từ menu để chuyển đổi giữa việc hiển thị và ẩn thông 
tin mẫu trên trình biên tập màn hình.
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(h) Vùng chạm
Chọn [View] → [Display Items] → [Touch Area] từ menu để chuyển đổi giữa việc hiển thị và ẩn vùng chọn trên 
trình biên tập màn hình.

(i) Tùy chọn
Chọn [View] → [Display Items] → [Option] từ menu để hiển thị hộp thoại [Option].
Trong hộp thoại này, bạn có thể thiết lập cấu hình cài đặt muốn hiển thị trên trình biên tập màn hình.

Tham khảo

Vui lòng tham khảo các chi tiết tùy chọn trong phần hỗ trợ hoặc GT Designer3(GOT2000) Screen Design Manual.

 ■ Vận hành thông qua việc sử dụng thanh công cụ

Cũng có thể chuyển đổi hiển thị của đối tượng thông qua việc sử dụng thanh công cụ [View].

Công tắc hiển thị ON/OFF Trạng thái số.

Biến số

Thiết bị nhãn hệ thống

ID đối tượng
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1

(1) Đặt một hiển thị số
Chọn [Object] → [Numerical Display/Input] → [Numerical Display] từ thanh menu để đặt một hiển thị số.

Gợi ý

Bạn cũng có thể chọn mục từ thanh công cụ.

(2) Cài đặt một biến và kích thước số cho hiển thị số

Nhấp đôi 
chuột!

1

1 Nhấp đôi chuột vào hiển thị số đã đặt.

Cài đặt 
“D10”. 2

Chọn 
“36”. 3

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

2 Device: D10

3 Number Size: Chọn 36 dot.

1.2.4 Tạo một hiển thị ộ số
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(3) Cài đặt hình dạng và màu khung cho hiển thị số

Nhấp chuột!

4

Chọn “Square_3D_Fixed 
Width : Rect_12”. 5

4 Chọn tab Style.

5 Chọn “Square_3D_Fixed Width : Rect_12” ở 
hình dạng.

Chọn 
“Gray”. 6

7
Nhấp chuột!

6 Chọn Gray ở Frame Color.

7 Nhấp chuột vào nút [OK].

Hoàn tất tạo hiển thị số.
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1

(1) Đặt một hình chữ nhật
Chọn [Figure] → [Rectangle] từ thanh menu để đặt một hình chữ nhật.

Gợi ý

Bạn cũng có thể chọn mục từ thanh công cụ.

Điểm đầu

Điểm cuối

Nhấp chuột!

1

Nhấp đôi 
chuột!

2

1 Vừa nhấp chuột vừa rê chuột từ điểm đầu đến 
điểm cuối.

2 Nhấp đôi chuột vào hình chữ nhật.

(2) Thay đổi cài đặt của hình chữ nhật

Nhấp chuột!

4

Chọn 
“Pattern: □ 8”, 
“Shape Color: Gray”, 
“Type: Rounded”, 
và “Radius: 5”.

3

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

3 Pattern: □ 8
Shape Color: Gray
Type: Rounded
Radius: 5 dots

4 Nhấp chuột vào nút [OK].

Hoàn tất tạo hình chữ nhật.

1.3 TẠO MỘT HÌNH
1.3.1 Tạo một hình (Hình chữ nhật)
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(3) Liên tục sao chép hình chữ nhật

Chọn

5

5 Chọn hình chữ nhật và chọn [Edit] → 
[Consecutive Copy] từ thanh menu.

Chọn “30”.

7

Chọn “3”.
6

Nhấp chuột!

8

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

6 Total count after copy: X 3

7 Interval: X 30

8 Nhấp chuột vào nút [OK] để liên tục sao chép 
hình chữ nhật.

Điểm lưu ý

Các hình được đặt trên lớp phía sau của các đối tượng.
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1

(1) Đặt một hình (Văn bản) 1
Chọn [Figure] → [Text] từ thanh menu để đặt một hình (Văn bản).

Gợi ý

Bạn cũng có thể chọn mục từ thanh công cụ.

Nhấp chuột!

1
1 Nhấp chuột vào vùng để nhập văn bản.

(2) Cài đặt hình (Văn bản) 1

Nhấp “Công 
tắc RUN”. 2

Chọn 
“Black”. 3

Nhấp chuột!

5

Nhấp chuột!

4

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

2 Text: Công tắc RUN
(Có thể chèn một tín hiệu chuyển dòng sau 
văn bản “Công tắc” bằng cách nhấn phím Enter. 
Điều chỉnh kích thước chữ.)

3 Text Color: Black

4 Alignment: Center

5 Nhấp chuột vào nút [OK].

Hoàn tất tạo hình (Văn bản) 1.

1.3.2 Tạo các hình (Văn bản) từ 1 tới 3
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(3) Liên tục sao chép hình (Văn bản) 1 để tạo ra các hình (Văn bản) 2 và 3

Chọn

6
6 Chọn hình (Văn bản) 1 và chọn [Edit] → 

[Consecutive Copy] từ thanh menu.

Chọn “3”. 7

Chọn “60”.

8

Nhấp chuột!

9

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

7 Total count after copy: X 3

8 Interval: X 60

9 Nhấp chuột vào nút [OK] để liên tục sao chép 
hình (Văn bản).
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1

(4) Sửa đổi văn bản của các bản sao

Nhấp đôi 
chuột!

10

10 Nhấp đôi chuột vào hình (Văn bản) 2 đã sao 
chép.

Nhấp “Công tắc 
STOP”. 11

Nhấp chuột!

12

Khi hộp thoại như bên trái hiện lên, cài đặt mục sau 
đây.

11 Text: Công tắc STOP
(Có thể chèn một tín hiệu chuyển dòng sau 
văn bản “Công tắc” bằng cách nhấn phím Enter. 
Điều chỉnh kích thước chữ.)

12 Nhấp chuột vào nút [OK].

Sửa đổi hình (Văn bản) 3 với cùng trình tự.
Text: Đèn báo hiệu đang vận hành
(Có thể chèn một tín hiệu chuyển dòng sau văn bản 
“Đèn báo” bằng cách nhấn phím Enter. Điều chỉnh 
kích thước chữ.)

Hoàn tất tạo các hình (Văn bản) 2 và 3.
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(1) Đặt một hình (Văn bản) 4
Chọn [Figure] → [Text] từ thanh menu để đặt một hình (Văn bản).
Bạn cũng có thể chọn hình (Văn bản) từ thanh công cụ.

Nhấp chuột!

1
1 Nhấp chuột vào vùng để nhập văn bản.

(2) Cài đặt hình (Văn bản) 4

Nhấp “Bảng 
điều khiển 
vận hành”. 2

Chọn “Outline 
Kaisho”. 3

Chọn “36”.

4

Nhấp chuột!

5

Khi hộp thoại như bên trái hiện lên, cài đặt các mục 
sau đây.

2 Text: Bảng điều khiển vận hành

3 Font: Outline Kaisho

4 Size: 36 dots

5 Nhấp chuột vào nút [OK].

Hoàn tất tạo hình (Văn bản) 4.

(3) Đặt và cài đặt một hình (Văn bản) 5 với cùng trình tự

Cài đặt các mục sau đây.
Text: Data 1
Font: Outline Gothic
Size: 16 dots

Hoàn tất tạo hình (Văn bản) 5.

1.3.3 Tạo các hình (Văn bản) 4 và 5
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1

(1) Chức năng chạm vuốt màn hình
Chức năng này cho phép phóng to và cuộn lên xuống màn hình giám sát của GOT.
Có thể cuộn lên xuống hoặc phóng to và thu nhỏ các nội dung được hiển thị của các đối tượng nhờ vào việc chạm 
trực tiếp trên màn hình GOT bằng các cử chỉ như khép 2 ngón tay vào và mở 2 ngón tay ra.

(Ví dụ) Mở 2 ngón tay ra trên màn hình để phóng to các nội dung đã hiển thị

(Ví dụ) Khép 2 ngón tay lại trên màn hình để thu nhỏ các nội dung đã hiển thị

Điểm lưu ý

Chức năng chạm vuốt màn hình mặc định được kích hoạt.

Nếu chức năng chạm vuốt màn hình bị vô hiệu hóa, thiết lập cấu hình cài đặt theo trình tự sau đây.

Chọn [Common] → [GOT Type Setting] từ thanh menu để hiển thị hộp thoại Type Setting.

Chọn [Use the gesture function] và nhấp chuột vào nút [OK].

Chức năng chạm vuốt màn hình được kích hoạt.

Nhấp chuột!

1.4 CÀI ĐẶT CHỨC NĂNG CHẠM VUỐT MÀN HÌNH
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(2) Tạo một đối tượng cho việc chạm vuốt màn hình
Đặt công tắc để chuyển đổi sang chế độ chạm vuốt màn hình.

Nhấp chuột!

1

1 Chọn [View] → [Docking Window] → [Library 
List] từ thanh menu.

Nhấp chuột!

2
2 Nhấp chuột vào biểu tượng  trên cửa sổ 

[Library List].

Nhấp chuột!

3

3 Chọn [System Library] → [Search By Function] 
→ [Gesture] từ menu kéo xuống được hiển thị.
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1Nhấp đôi 
chuột!

4

4 Nhấp đôi chuột vào [Gesture_Title(VGA)].

Nhấp chuột!

5

5 Kiểu đã đăng ký sẽ được hiển thị theo một 
danh sách. Nhấp chuột vào [1 Gesture01_B].

Nhấp chuột!

6
6 Di chuyển con trỏ tới trình biên tập màn hình, 

và nhấp chuột vào góc phía trên bên trái màn 
hình.
(Đường nét đứt chỉ kích thước của đối tượng sẽ 
hiện ra.)

Đã đặt đối tượng cho việc chạm vuốt màn hình.

Điểm lưu ý

Chức năng của đối tượng cho việc chạm vuốt màn hình

 ● Chuyển đổi sang chế độ chạm vuốt màn hình

Chạm để chuyển đổi 
chế độ.Chạm vào biểu tượng sau đây sẽ chuyển đổi sang chế độ chạm vuốt 

màn hình.

 ● Hủy chế độ chạm vuốt màn hình

Chạm để hủy 
chế độ.Chạm vào biểu tượng sau đây trong chế độ chạm vuốt màn hình sẽ 

hủy chế độ chạm vuốt màn hình.

 ● Hiển thị kích thước thực (100%)

Chạm để thay đổi 
hiển thị sang 
hiển thị kích thước thực.

Chạm vào biểu tượng sau đây để định lại kích thước màn hình đã 
mở rộng thông qua việc sử dụng chức năng chạm vuốt với kích 
thước thực tế (100%).
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(3) Hiển thị vùng không hoạt động chạm vuốt màn hình
“Vùng không hoạt động chạm vuốt màn hình”, là vùng cho 16 đến 100 dot từ phía trên của màn hình hoặc từ phía 
dưới của màn hình, không phải là mục tiêu để phóng to và thu nhỏ và cuộn lên xuống trong khi sử dụng chức năng 
chạm vuốt.

Nhấp chuột!

7

7 Chọn [Screen] → [Screen Property] từ thanh 
menu.

Nhấp chuột!

9

Kiểm tra 8

8 Chọn [Display the screen gesture inactive area].

9 Nhấp chuột vào nút [OK].

Hoàn tất cài đặt chức năng chạm vuốt màn hình.
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1

(1) Kiểm tra trạng thái hiển thị bật và tắt của màn hình và đối tượng đã tạo
Chọn [View] → [Preview] từ thanh menu.

Nhấp chuột!

1
1 Cửa sổ Screen Preview sẽ hiện ra. Nhấp chuột 

vào nút [ON].

Các hình dạng của 
trạng thái bật sẽ 
được hiển thị. 2

Nhấp chuột!

3
2 Hình dạng của các đối tượng sẽ được chuyển 

đổi sang hình dạng của trạng thái bật.

3 Nhấp chuột vào nút [OFF] sẽ hiển thị hình dạng 
của trạng thái tắt.

1.5 KIỂM TRA MÀN HÌNH ĐÃ TẠO
1.5.1 Kiểm tra hiển thị (Xem trước màn hình)
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 ■ Kiểm tra hiển thị của các đèn và công tắc của từng đối tượng

Trên cửa sổ Screen Preview, có thể chuyển đổi hiển thị của các đèn và công tắc để kiểm tra từng hiển thị.

(1) Chuyển đổi trạng thái ON/OFF

Nhấp chuột phải!

1

Nhấp chuột!

2

1 Nhấp chuột phải vào một đối tượng.

2 Chọn [ON] hoặc [OFF].

Hình dạng của trạng 
thái bật

Hình dạng của trạng 
thái tắt

Hình dạng của trạng thái bật hoặc tắt sẽ được hiển 
thị.
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1

(2) Thay đổi giá trị xem trước của hiển thị số hoặc đầu vào số

Nhấp chuột!

2

Nhấp chuột phải!

1
1 Nhấp chuột phải vào hiển thị số.

2 Chọn [Change Preview Value].

Nhấp chuột!

4

Nhập một 
giá trị. 3

3 Nhập một giá trị.

4 Nhấp chuột vào nút [OK].

Giá trị xem trước được thay đổi.
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(1) Kiểm tra việc không có lỗi tồn tại trong project
Chọn [Tool] → [Data Check] → [Check] từ thanh menu.

Hiển thị 
hoàn tất 1

1 Kiểm tra tin nhắn [Data Check is completed.] 
hiển thị trên cửa sổ Data Check List và không 
có lỗi tồn tại.

Nhấp đôi 
chuột!

2

2 Nếu có bất kỳ lỗi nào tồn tại, nhấp đôi chuột 
vào kết quả để nhảy đến vị trí gây ra lỗi hoặc 
cảnh báo.
Kiểm tra lỗi và thay đổi cài đặt.

Gợi ý

Có thể cài đặt các mục để kiểm tra với việc kiểm tra dữ liệu.

Chọn [Tool] → [Data Check] → [Item Setting] từ thanh menu.

Chọn các mục 
kiểm tra.

1.5.2 Kiểm tra lỗi dữ liệu (Kiểm tra dữ liệu)
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1

(1) Chuẩn bị chương trình tuần tự
Chuẩn bị một chương trình tuần tự cho các giả lập sử dụng bộ giả lập.
Để tiến hành bước tiếp theo, tạo một chương trình tuần tự sử dụng GX Works3.

<Chương trình mẫu>

(2) Khởi động bộ giả lập cho PLC
Khởi động GX Simulator3 từ GX Works3.

Nhấp chuột!

1

1 Chọn [Debug] → [Simulation] → [Start 
Simulation] từ thanh menu của GX Works3.

GX Simulator3 bắt đầu.

1.5.3 Kiểm tra vận hành (Bộ giả lập)
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(3) Khỏi động bộ giả lập cho GOT để kiểm tra màn hình đã tạo
Khởi động Simulator3 từ GT Designer3(GOT2000) để kiểm tra màn hình đã tạo.

Nhấp chuột!

2

2 Chọn [Tools] → [Simulator] → [Set] từ thanh 
menu của GT Designer3(GOT2000).

Chọn 
“GX Simulator3”. 3

Nhấp chuột!

4

3 Khi hộp thoại như bên trái hiện lên, chọn GX 
Simulator3 ở Connection.

4 Nhấp chuột vào nút [OK] để hoàn tất cài đặt.

Nhấp chuột!

5

5 Chọn [Tools] → [Simulator] → [Activate] từ 
thanh menu của GT Designer3(GOT2000).
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1
Bộ giả lập bắt đầu, và có thể giả lập màn hình đã tạo.

Đèn sẽ bật 
và giá trị 
chuyển thành 6666. 7

Nhấp chuột!

6

6 Nhấp chuột vào nút RUN.

7 Đèn báo hiệu đang vận hành sẽ bật và giá trị 
của Data 1 chuyển thành 6666.

Gợi ý

Có thể khởi động, nâng cấp, và thoát bộ giả lập khỏi thanh công cụ của 

GT Designer3(GOT2000).
(1) (2) (3) (4)

(1) [Simulator: Activate] Kích hoạt GT Simulator3 để khởi động các giả lập.

(2) [Simulator: Update]  Nâng cấp project trong các giả lập với project đang được chỉnh sửa. 
Có thể mang lại các thay đổi được tạo ra bằng cách sử dụng GT Designer3(GOT2000)  
cho project trong giả lập.

(3) [Simulator: Set] Mở cửa sổ cài đặt của bộ giả lập.

(4) [Simulator: End] Thoát GT Simulator3.
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Đèn sẽ tắt 
và giá trị 
chuyển thành 3333. 9

Nhấp chuột!

8

8 Nhấp chuột vào nút STOP.

9 Đèn báo hiệu đang vận hành sẽ tắt và giá trị 
của Data 1 chuyển thành 3333.

(4) Thoát bộ giả lập cho GOT
Thoát GT Simulator3 sau giả lập.

Nhấp chuột!

10

10 Chọn [Tools] → [Simulator] → [Exit] từ thanh 
menu của GT Designer3(GOT2000).

(5) Thoát bộ giả lập cho PLC
Thoát GX Simulator3 của GX Works3.

Nhấp chuột!

11

11 Chọn [Debug] → [Simulation] → [Stop 
Simulation] từ thanh menu của GX Works3.
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1

(1) Lưu màn hình đã tạo

Nhấp chuột!

1

1 Chọn [Project] → [Save As] từ thanh menu.

Nhập tên tập tin và 
nhấp chuột vào nút Save.

2

2 Nhập tên tập tin và nhấp chuột vào nút [Save] 
để lưu màn hình.

(2) Loại tập tin
Có thể lưu một project theo những định dạng sau đây.
• Định dạng miền làm việc
• Định dạng tập tin đơn (*.GTX)
• Định dạng tập tin đơn (*.GTXS) với các ứng dụng hệ thống

Tham khảo

Tài liệu này giải thích về một project định dạng tập tin đơn (*.GTX).

Vui lòng tham khảo các chi tiết của từng định dạng trong phần hỗ trợ hoặc GT Designer3(GOT2000) Screen Design 
Manual.

1.6 LƯU PROJECT
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Ghi chú
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2

BƯỚC 2 

TRUYỀN DỮ LIỆU PROJECT
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Sử dụng cáp USB để kết nối máy tính cá nhân với GOT.

Cổng kết nối USB

Máy tính cá nhân

GOT

Mở nắp trước và 
kết nối cáp đến 
cổng mini USB.

Cáp USB 
(GT09-C30USB-5P)

* Cài đặt một trình điều khiển USB cho giao tiếp USB với GOT.
Trình điều khiển USB được cài đặt cho máy tính cá nhân vào lần kết nối đầu tiên.
Cũng có thể truyền dữ liệu thông qua việc sử dụng một thẻ SD hoặc phương pháp kết nối khác với cáp USB.

Tham khảo

Vui lòng tham khảo việc làm thế nào để truyền dữ liệu thông qua việc sử dụng một thẻ SD hoặc phương pháp kết nối 

khác với cáp USB trong phần hỗ trợ hoặc GT Designer3(GOT2000) Screen Design Manual.

2.1 TRUYỀN DỮ LIỆU PROJECT
2.1.1 Kết nối máy tính cá nhân với GOT
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2

Thiết lập cấu hình mục thiết lập giao tiếp trong máy tính cá nhân và GOT.
Bật nguồn GOT trước khi thiết lập cấu hình.

Nhấp chuột!

1
1 Chọn [Communication] → [Write to GOT] từ 

thanh menu.

Nhấp chuột!

3

Kiểm tra “Connection to 
GOT: Direct” và “PC side I/F: 
USB” được chọn. 2

2 Kiểm tra những cài đặt được thiết lập
sau đây.
Connection to GOT: Direct 
PC side I/F: USB

Thực hiện các thử nghiệm truyền thông để kiểm tra 
truyền thông.

3 Nhấp chuột vào nút [Test].

Nhấp chuột!

4

4 Khi tin nhắn [Successfully connected.] hiện ra, 
nhấp chuột vào nút [OK].

Nhấp chuột!

5

5 Nhấp chuột vào nút [OK].

2.1.2 Thiết lập giao tiếp
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Truyền dữ liệu project từ máy tính cá nhân tới GOT.

Kiểm tra “Write Data: Package Data” 
và “Destination Drive: C:Built-in 
Flash Memory”. 6

Nhấp chuột!

7

6 Kiểm tra những cài đặt được thiết lập
sau đây.
Write Data: Package Data
Destination Drive: C:Built-in Flash Memory

7 Nhấp chuột vào nút [GOT Write].

Nhấp chuột!

8

Hộp thoại xác nhận ghi vào GOT sẽ hiện ra.

8 Nhấp chuột vào nút [YES] để bắt đầu ghi.

Hộp thoại như bên trái sẽ được hiển thị trong khi dữ 
liệu đang được ghi.
Không thực hiện các thao tác sau đây.
• Tắt GOT
• Rút cáp
• Mở nắp thẻ SD

Nhấp chuột!

9

9 Khi việc ghi vào GOT hoàn tất, hộp thoại như 
bên trái sẽ hiện ra. Nhấp chuột vào nút [OK].

2.1.3 Truyền dữ liệu project



2-5

2

GOT sẽ tự động khởi động lại.

10 Màn hình lựa chọn ngôn ngữ sẽ hiện ra. Chọn 
[English].
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Kết nối GOT và PLC.
Trước khi kết nối GOT và PLC, kiểm tra xem đã tắt nguồn của GOT và PLC chưa.

Sau đó, kết nối GOT và PLC thông qua việc sử dụng cáp Ethernet, và bật nguồn GOT và PLC lên.

Kết nối với cổng Ethernet 
của GOT ở mặt sau

GOT

PLC

Kết nối với cổng Ethernet 
của PLC ở mặt trước

2.2 KẾT NỐI GOT VÀ PLC
2.2.1 Kết nối GOT và PLC
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Thực hiện kiểm tra trạng thái Ethernet của GOT để kiểm tra xem GOT có thể giao tiếp với PLC không.
Chức năng kiểm tra trạng thái Ethernet sẽ kiểm tra trạng thái kết nối giữa GOT và một thiết bị trên mạng Ethernet bằng 
cách gửi đi một yêu cầu ping.
Trước khi thực hiện kiểm tra trạng thái Ethernet, vui lòng kiểm tra xem đã bật nguồn GOT và PLC chưa.

1

1 Chạm vào phím gọi utility trên GOT để hiển thị 
menu chính utility.

Phím gọi utility được cài đặt ở góc phía trên 
bên trái của màn hình GOT (nhấn phím trong 2 
giây).
Có thể thay đổi các cài đặt với 
GT Designer3(GOT2000).

Menu chính utility được hiển thị.

2.2.2 Kiểm tra trạng thái kết nối
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2

2 Chạm vào [Maintenance] → [Ethernet status 
check] trên menu chính utility.

3

3 Cài đặt địa chỉ IP của bộ điều khiển mục tiêu và 
chạm vào nút [Ping transmission].

Trong tài liệu này, địa chỉ IP của bộ điều khiển 
mục tiêu là 192.168.3.39 (mặc định).
Có thể kiểm tra và thay đổi địa chỉ IP của bộ 
điều khiển mục tiêu trong [Ethernet Setting] 
bằng cách chọn [Common] → [Controller 
Setting] từ thanh menu của 
GT Designer3(GOT2000).

4

5

Khi không có lỗi giao tiếp tồn tại, tin nhắn [Response 
received.] sẽ hiện ra.

4 Chạm vào nút [OK].

5 Chạm vào nút [×] để hiển thị màn hình đã tạo.



2-9

2

Ghi chương trình tuần tự, được tạo ra cho việc giả lập, từ GX Works3 tới PLC.

2.2.3 Ghi chương trình tuần tự vào PLC
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Ghi chú
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3

BƯỚC 3 

SỬ DỤNG GOT
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Chạm vào từng công tắc để kiểm tra hoạt động chuyển đổi.

(1) (2) (3)

(4)

Hiển thị màn hình đã tạo.
Dưới đây cho thấy cài đặt hoạt động của từng đối tượng.

(1) Công tắc RUN
Chạm vào công tắc này sẽ bắt đầu vận hành (M0 sẽ bật).

(2) Công tắc STOP
Chạm vào công tắc này sẽ dừng vận hành (M1 sẽ bật).

(3) Đèn báo hiệu đang vận hành
RUN: Đèn sẽ bật với văn bản “RUN”. (Khi M0 bật, Y10 sẽ bật.)

(Y10 bật bởi chương trình tuần tự.)
STOP: Đèn sẽ tắt với văn bản “STOP”. (Khi M1 bật, Y10 sẽ tắt.)

(Y10 tắt bởi chương trình tuần tự.)

(4) Data 1 (Hiển thị số)
RUN: Hiển thị giá trị số 6666. (Khi M0 bật.)

(Giá trị 6666 sẽ được lưu trữ trong D10 bởi chương trình tuần tự.)
STOP: Hiển thị giá trị số 3333. (Khi M1 bật.)

(Giá trị 3333 sẽ được lưu trữ trong D10 bởi chương trình tuần tự.)

3.1 KIỂM TRA HOẠT ĐỘNG BẬT/TẮT CỦA CÁC CÔNG TẮC
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3

1

1 Chạm vào công tắc RUN sẽ bật đèn báo hiệu 
đang vận hành và hiển thị 6666 trong Data 1.

2

2 Chạm vào công tắc STOP sẽ bật đèn báo hiệu 
đang vận hành và hiển thị 3333 trong Data 1.
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Có thể phóng to và thu nhỏ màn hình giám sát bằng cách sử dụng chức năng chạm vuốt màn hình.

1

1 Chạm vào công tắc để chuyển đổi sang chế độ 
chạm vuốt màn hình.

2

2 Đường màu đỏ chỉ vùng có thể phóng to và 
thu nhỏ sẽ hiện ra.

3

3 Có thể phóng to và thu nhỏ màn hình bằng 
cách khép 2 ngón tay lại hoặc mở 2 ngón tay ra 
trên vùng này.

3.2 SỬ DỤNG CHỨC NĂNG CHẠM VUỐT MÀN HÌNH
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54

4 Để hủy chế độ chạm vuốt màn hình, chạm vào 
công tắc để chuyển đổi chế độ chạm vuốt màn 
hình.
Chế độ chạm vuốt màn hình bị hủy và hiển thị 
màn hình vẫn mở rộng.

5 Chạm vào công tắc hiển thị kích thước thực 
(100%) để thay đổi hiển thị kích thước thực.
Khi hiển thị màn hình được thay đổi sang kích 
thước thực trong chế độ chạm vuốt màn hình, 
chế độ chạm vuốt màn hình sẽ bị hủy và màn 
hình sẽ được hiển thị ở kích thước thực.
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3.3 DANH SÁCH CÁC CHỨC NĂNG GOT

GOT có nhiều chức năng hữu ích. Phần này sẽ giới thiệu vài chức năng.

Chạm vào công tắc để thay đổi giá trị của biến 
dạng word.

Chạm vào công tắc để chuyển đổi màn hình 
sang màn hình utility hoặc các màn hình khác.

Chuyển đổi từ Chuyển đổi chức năng đặc biệt

Chạm vào công tắc để chuyển đổi các màn hình 
nền và màn hình cửa sổ.

Đi đến chuyển đổi màn hình

Công tắc hiển thị cửa sổ bàn phím

Một cửa sổ khóa chỉ định sẽ được hiển thị tại một 
vị trí chỉ định, và một con trỏ sẽ được hiển thị 
trên một đối tượng chỉ định.

Chạm vào công tắc để bật hoặc tắt biến dạng Bit.

Chuyển mạch bit

Chạm vào công tắc để chuyển đổi số trạm của 
bộ điều khiển được giám sát.

Công tắc thay đổi số trạm

Thay đổi 
mục tiêu 
giám sát.

Thay đổi màu sắc của đèn.

Hiển thị đèn

Công tắc mã khóa

Màn hình nền 1 Màn hình nền 2

150 1500

Có thể sử dụng công tắc này như một phím để 
nhập các giá trị số hoặc văn bản.

Đèn, công tắc

D100:

M0: BẬT → TẮT

200 → 350
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Các giá trị được ghi vào trong biến.

Đầu vào số
Một giá trị biến được hiển thị với một giá trị số.

Hiển thị số

334D100
45D100

Mã ký tự được nhập vào một thiết bị.

A B C D

Đầu vào văn bản

Một giá trị biến được hiển thị với một ký tự.

MITSUBISHI

Hiển thị văn bản

STOP

Hiển thị chú thích

Một chú thích được hiển thị.

RUN STOP

Ngày và giờ được hiển thị.

Hiển thị đồng hồ

07/08/24

15:27

Hiển thị văn bản, số

D100: 334 STOPD100: 45

D10: 4241H (BA)
D11: 4443H (DC)

004D:
0049:
0054:
0053:
0055:
0042:
0049:
0053:
0048:
0049:

M
I
T
S
U
B
I
S
H
I

Các bộ phận
Di chuyển các bộ phậnHiển thị các bộ phận

Hiển thị các bộ phận đã đăng ký. Hiển thị di chuyển của các bộ phận.

Bộ phận 1 Bộ phận 2
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Biểu đồ, đồng hồ * Ở đây chỉ giới thiệu một vài chức năng.

Hiển thị biểu đồ thống kê Hiển thị biểu đồ xu hướng lịch sử

Hiển thị mức độHiển thị đồng hồ bảng

Điều kiện → Vận hành
Chức năng thời gian hoạt độngChức năng ghi lại

Một giá trị biến được hiển thị với một đồng hồ.

Nhiều giá trị biến được hiển thị trên một biểu đồ 
với tỷ lệ phần trăm trên tổng số.

Một giá trị biến được hiển thị với tỷ lệ phần trăm 
trên tổng số.

Biểu đồ tròn Biểu đồ cột

Dữ liệu bao gồm dữ liệu quá khứ và hiện tại đã 
thu thập bằng cách sử dụng chức năng ghi lại 
được hiển thị với một biểu đồ xu hướng.

Các giá trị biến được thu thập và lưu giữ. Các biến có thể được ghi vào ngày và giờ quy 
định.

Công thứcCon trượt
Chức năng công thứcCon trượt

Trạng thái của các biến sẽ được giám sát, và các 
giá trị biến sẽ được đọc và ghi khi thỏa mãn các 
điều kiện. Nhiều giá trị có thể được cài đặt cho 
một biến. Các giá trị biến có thể được đọc và ghi 
bằng cách sử dụng utility.

Sử dụng con trượt để cài đặt các giá trị nối tiếp 
cho thiết bị trong phạm vi cài đặt bất kỳ. Giá trị 
của điểm đến mà bạn dừng nút bấm là đầu vào 
thiết bị.

Đọc/
Ghi

Thay đổi đầu ra cài đặt với con trượt

* Ở đây chỉ giới thiệu một vài chức năng.

Production line
Current output
Set output

Production line
Current output
Set output

→  

D100:
D101:
D102:

150 250
500300 
235208
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Khác

Trình giám sát thiết bị Sao lưu/Khôi phục

Chuyển đổi ngôn ngữHiển thị tài liệu

Giám sát trạng thái của các thiết bị PLC. Các cài đặt của bộ điều khiển có thể được sao 
lưu hoặc khôi phục từ GOT.

Có thể chuyển đổi đa ngôn ngữ để hiển thị 
được một ngôn ngữ thích hợp.

Có thể hiển thị dữ liệu tài liệu trên GOT.

Sao lưu

Khôi phục

* Ở đây chỉ giới thiệu một vài chức năng.

English

Hello

M10  ●
M20  ○
D100  255

M10 BẬT
M20 TẮT
D100 255

I/O bên ngoài * Ở đây chỉ giới thiệu một vài chức năng.

Mã vạch Bảng điều khiển

Hiển thị videoBáo cáo

Đọc dữ liệu với đầu đọc mã vạch được ghi cho 
các thiết bị.

Các thiết bị được ghi bằng cách vận hành 
bảng điều khiển.

Thu thập dữ liệu như quản lý sản xuất và trạng 
thái sản xuất và in dữ liệu đã thu thập ra.

Hiển thị ảnh video.

150
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3.4 Chức năng thuận tiện cho việc bảo trì

Báo động

Hiển thị báo động đơn giản Hiển thị báo động hệ thống

Hiển thị màn hình giao diện con báo độngHiển thị báo động
Hiển thị lỗi GOT, các lỗi truyền thông, thông báo 
đã tạo bởi người dùng như lịch sử khi có một 
báo động xảy ra. 
Báo động được hiển thị có phân cấp.

Hiển thị lỗi GOT, các lỗi truyền thông, các thông 
báo đã tạo bởi người dùng với cửa sổ giao diện 
con khi có một báo động xảy ra.

Hiển thị một thông báo đã tạo bởi người dùng 
khi có một báo động xảy ra.

Hiển thị các lỗi GOT và các lỗi truyền thông khi 
có một báo động xảy ra.

13:25 Line A stop

13:25 Line A stop
13:05 Upper limit over
13:03 Motor trip

Time  Message

02/04/18  13:25:40
Line stop

307 No monitor device 
is set.

Chức năng GOT Mobile
Chức năng này sẽ giám sát những biến đã kết nối thông qua GOT từ các thiết bị thông tin như máy tính cá 
nhân, máy tính bảng và điện thoại thông minh.
Người dùng có thể dễ dàng nắm bắt được trạng thái của biến trên trình duyệt web từ một nơi xa.
5 thiết bị có thể truy cập vào 1 thiết bị GOT tại cùng một thời điểm.

2 3

41 5

Điện thoại thông minh Máy tính bảngMáy tính bảngGOT

PCTrình giám sát PC và màn hình lớn

Trang web 
sản xuất

Văn phòng
Văn phòng hoặc địa điểm từ xa
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Chức năng trình xem bản ghi

Date and time

2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Date and time
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00
2009/04/06 10:30:00

150
152
158
170

Line 1
100
98
95
92

Line 2
250
260
270
280

Line 3

Ngay cả khi không thể truy cập vào trình duyệt web trên máy tính cá nhân, GOT có thể tiếp thu (ghi lại) và 
hiển thị dữ liệu trong thiết bị đã kết nối ví dụ như bộ điều khiển lập trình bằng cách sử dụng chức năng 
truy cập, xem lại bản ghi chép trên trình duyệt web.

Chức năng của thông tin bản ghi vận hành
Chức năng này sẽ lưu các thao tác đã thực hiện bởi người dùng tới GOT trong việc lưu trữ dữ liệu làm bản 
ghi vận hành. Các thao tác được lưu trong bản ghi có thể được sử dụng trong việc điều tra nguyên nhân 
thực hiện nếu có vấn đề xảy ra trên trang web sản suất.

Danh sách dữ liệu trong bản ghi vận hành

Xác định phác thảo của bản ghi

Thông tin chi tiết

Xác định các chi tiết của bản ghi

Tiếp thu dữ liệu ghi lại Lưu trữ dữ liệu

Dữ liệu ghi lại Dữ liệu ghi lại



3-12

Các mẫu màn hình
Các màn hình khác nhau được xếp thành hàng để cho thấy các chức năng thường được sử dụng trên 
trang web địa phương. Bằng cách đề cập đến các mẫu màn hình, người dùng không được tạo các màn 
hình tương tự từ lúc bắt đầu. Nếu bạn cần các ví dụ về màn hình, hãy tham khảo ý kiến của văn phòng đại 
diện hoặc chi nhánh Mitsubishi tại địa phương của bạn.

Hiển thị biểu đồ xu hướng Hiển thị bộ đếm Cài đặt tham số

Vận hành_hướng dẫn sử dụng Hiển thị_báo động_hiện tại

Mật khẩu
Có thể cài đặt quyền vận hành và duyệt GOT bằng cách cài đặt tên người vận hành mật khẩu cho từng 
người dùng. Cài đặt mật khẩu giúp “tăng cường an ninh” và “kiểm soát việc truy cập đối với từng người 
dùng”. Bằng cách kết hợp chức năng mật khẩu và thông tin bản ghi vận hành, bạn có thể kiểm tra xem là 
“ai (người), khi nào (ngày và giờ), làm cái gì (dữ liệu mục tiêu) và làm như thế nào (phương pháp)” của 
từng vận hành đã thực hiện.

Được phép 
đăng nhập

Người vận hành A 
có quyền 
vận hành

Người vận hành B 
không có quyền 

vận hành

Không được phép 
đăng nhập
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BƯỚC 4 

BẢO TRÌ GOT
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Thiết bị FA có thể đương đầu với các môi trường khác nhau bao gồm sự thay đổi nhiệt độ và rung động, và đảm nhiệm 
làm lực truyền động chính trên trang web sản xuất.
Tuy nhiên, thiết bị FA là các thiết bị điện tử chính xác, và có thể hỏng bất ngờ. Đặc biệt, GOT được lắp đặt bên ngoài tủ 
điều khiển nên có thể dễ dàng bị ảnh hưởng bởi áp lực bên ngoài.
Nếu các thiết bị FA bị hỏng hóc liên tục trong thời gian dài, năng suất có thể bị sụt giảm đáng kể. Cần sửa chữa các thiết 
bị FA đã hỏng càng sớm càng tốt.
Khoảng thời gian trong lúc máy móc bị dừng lại do hỏng hóc được gọi là “thời gian chết”.
Chương 4 giải thích 3 điều cơ bản sau đây của việc bảo trì được yêu cầu để duy trì trạng thái bình thường của GOT:

1. Sao lưu
2. Báo động
3. Pin

4.1 SỰ CẦN THIẾT CỦA VIỆC BẢO TRÌ
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Có thể sao lưu dữ liệu GOT và dữ liệu thiết bị đã kết nối.
Sử dụng chức năng utility của GOT để sao lưu dữ liệu.
Chức năng utility được thiết kế để kết nối GOT và các thiết bị, cài đặt dữ liệu trên màn hình, cài đặt các trình tự vận 
hành, quản lý các chương trình/dữ liệu và thực hiện tự chẩn đoán.

Trước khi sao lưu
Cần cài đặt ứng dụng hệ thống (các chức năng mở rộng) trên ổ đĩa C của GOT (bộ nhớ flash tích hợp).
(1) Cài đặt ứng dụng hệ thống (các chức năng mở rộng)

Trước khi cài đặt ứng dụng hệ thống (các chức năng 
mở rộng), thực hiện cài đặt sau đây.
→  2.1.1 Kết nối máy tính cá nhân với GOT
→ 2.1.2 Thiết lập giao tiếp

Nhấp chuột!

1

1 Nhấp chuột vào nút [Write Option].

Hộp thoại [Write Option] sẽ được hiển thị.

Nhấp chuột!

2

2 Nhấp chuột vào nút [Application Selection].

4.2 SAO LƯU
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Hộp thoại [Application Selection] sẽ được hiển thị.

3

4

Nhấp chuột!

Nhấp chuột!

3

4

Chọn [Backup/Restoration].

Nhấp chuột vào nút [OK].

Nhấp chuột!

5

5 Nhấp chuột vào nút [GOT Write], và việc ghi sẽ 
bắt đầu.
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Sao lưu là tạo một bản sao của dữ liệu.
Nếu có bất kỳ thiết bị nào bị hư hỏng hoặc phải thay thế bằng một thiết bị mới, dữ liệu trong thiết bị có thể được sửa 
chữa từ bản đã sao lưu.
Đối với GOT, có hai phương pháp sao lưu, 1 là kết nối với một máy tính cá nhân, và 2 là sử dụng một thẻ SD.
Lần này, giải thích trình tự sao lưu trên một thẻ SD trên giả định rằng máy tính cá nhân không có sẵn hoặc dữ liệu 
không được đưa lên trang web.

Chức năng tiếp thu (sao lưu) gói dữ liệu GOT
Sử dụng chức năng tiếp thu gói dữ liệu GOT để sao lưu dữ liệu đã cài đặt trong thiết bị chính GOT.
Chức năng tiếp thu gói dữ liệu GOT được thiết kế để sao chép tất cả các dữ liệu cài đặt trong GOT vào trong một thẻ SD. 
(Tiếp thu gói dữ liệu GOT)
Dữ liệu đã sao chép có thể được cài đặt vào một GOT khác để tạo ra hệ thống tương tự của GOT. (Cài đặt dữ liệu GOT)

Luồng công việc

GOT GOT

Thẻ SD

Cài đặt dữ liệu GOT
(Khôi phục)

Tiếp thu (Sao lưu) 
gói dữ liệu GOT

4.2.1 Sao lưu dữ liệu GOT
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(1) Trình tự tiếp thu (sao lưu) gói dữ liệu GOT

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [Backup Restoration] trên màn hình 
[Data mng.] trong [Utility main menu].

3

3 Chạm vào [GOT data package acquisition (GOT 
data)].
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4

5

4

5

Chạm vào tên ổ đĩa bên dưới [Select Drive] sẽ 
đảo ngược tên ổ đĩa đã chạm.

Chạm vào nút [Copy] sẽ bắt đầu sao chép.

Sau khi sao chép dữ liệu và ứng dụng hệ thống, hộp 
thoại thông báo hoàn thành sẽ xuất hiện.

6

6 Chạm vào nút [OK] sẽ đóng hộp thoại.

Sau đó, việc tiếp thu (sao lưu) gói dữ liệu GOT sẽ 
được hoàn tất.
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(2) Trình tự cài đặt (sửa chữa) dữ liệu GOT

Công tắc cài đặt
(S.MODE)

2

1

2

Tắt nguồn GOT, và chèn thẻ SD có chứa dữ liệu 
vào trong khe cắm thẻ SD của GOT.
Xem phần sau đây về các trình tự cho việc chèn 
thẻ SD. (Trang PHỤ LỤC 2-9 trong văn bản này)
→  PHỤ LỤC 2-7 Lắp/Tháo thẻ SD

Bật nguồn GOT trong lúc nhấn công tắc cài đặt 
(Công tắc S.MODE) ở phía sau của GOT.

Do you want to excute installation?

O  K Hủy3

3 Chạm vào [OK]. Dữ liệu sẽ được cài đặt vào bên 
trong bộ nhớ flash tích hợp.

Install now…
4 Đèn LED báo hiệu đang truy cập thẻ SD sáng 

lên trong khi thực hiện cài đặt.
Không rút thẻ SD ra hoặc TẮT nguồn GOT trong 
lúc đèn LED báo hiệu đang truy cập thẻ SD 
sáng lên.
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Installation has been completed.

O  K 5

5 Chạm vào [OK]. GOT sẽ tự động khởi động lại.

6 Sau khi xác nhận khởi động lại bình thường, 
xác nhận đèn LED báo hiệu đang truy cập thẻ 
SD không còn sáng, và tháo thẻ SD
khe cắm thẻ nhớ SD của GOT.
Xem phần sau đây về các trình tự cho việc tháo 
thẻ SD. (Trang PHỤ LỤC 2-9 trong văn bản này)
→  PHỤ LỤC 2-7 Lắp/Tháo thẻ SD

Sau đó, việc cài đặt (sửa chữa) sẽ được hoàn tất.
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Đối với một bộ điều khiển đã kết nối với GOT, có thể lưu (sao lưu) dữ liệu cài đặt, bao gồm một chương trình tuần tự, 
tham số, và các giá trị cài đặt vào một thẻ nhớ hoặc bộ nhớ USB trong GOT.
Với việc sao lưu dữ liệu cài đặt cho một bộ điều khiển, dữ liệu có thể được sửa chữa vào bộ điều khiển với GOT đã kết 
nối với bộ điều khiển cho dù bộ điều khiển đã bị thay thế do các vấn đề như là bị hỏng hóc. Kết quả là, hệ thống có thể 
sửa chữa dễ dàng.

Chức năng sao lưu (Thiết bị→GOT)
Chức năng sao lưu được sử dụng để sao chép dữ liệu trong thiết bị đã kết nối với GOT vào trong một thẻ SD.

Chức năng khôi phục (GOT→Thiết bị)
Chức năng khôi phục được sử dụng để trả lại dữ liệu thiết bị đã lưu trong thẻ SD vào thiết bị.

Luồng công việc

GOT

Thiết bị

Sao lưu dữ liệu cài đặt 
vào thẻ SD

Khôi phục dữ liệu sao lưu 
vào bộ điều khiển.

Thẻ SD

4.2.2 Sao lưu dữ liệu trong các thiết bị kết nối
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(1) Cài đặt địa chỉ đích để lưu dữ liệu sao lưu

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [Backup Restoration] trên màn hình 
[Ext. func. set] trong [Utility main menu].

3

4

3 Nếu chạm vào mục cài đặt, nội dung cài đặt sẽ 
được thay đổi.
Cài đặt “Drive for backup data” vào [A: Built-in 
SD card].

4 Nếu chạm vào nút [OK] được đề cập ở trang 
trước, các cài đặt đã thay đổi sẽ được phản ánh 
và màn hình sẽ trở lại màn hình [Ext. func. set].
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(2) Vận hành chức năng sao lưu (Thiết bị→GOT)

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [Backup restration] trên màn hình 
[Data mng.] trong [Utility main menu].

3

3 Chạm vào [Backup function (Device→GOT)].
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4

4 Cửa sổ như bên trái sẽ được hiển thị. Chạm vào 
nút [OK].

“Backing up” sẽ lóe lên trong cột Status.

5 Việc sao lưu dữ liệu trong thiết bị đã kết nối sẽ 
bắt đầu.

6

Sau khi hoàn tất sao lưu dữ liệu trong thiết bị đã kết 
nối, hộp thoại thông báo hoàn tất sẽ được hiển thị.

6 Chạm vào nút [OK].

7

“Completed” sẽ được hiển thị trong cột Status.

7 Chạm vào nút [Close].

Sau đó, việc sao lưu (Thiết bị→GOT) sẽ được hoàn 
tất.
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(3)  Vận hành chức năng khôi phục (GOT→Thiết bị)

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [Backup restration] trên màn hình 
[Data mng.] trong [Utility main menu].

3

3 Chạm vào [Restoration function 
(GOT→Device)].
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4 5

6

Dữ liệu sao lưu được lưu trữ trong thẻ SD sẽ được 
hiển thị ở dạng danh sách.

4

5

6

Chọn dữ liệu sao lưu được sửa chữa bằng cách 
chạm vào dữ liệu.

Chạm vào tên thiết bị (dữ liệu của thiết bị đã 
kết nối sẽ được trả lại).

Chạm vào nút [Execute].

7

7 Cửa sổ như bên trái sẽ được hiển thị. Chạm vào 
nút [OK].

8

Sau đó, cửa sổ như bên trái sẽ được hiển thị. Bạn có 
thể chọn việc có giữ lại các thông tin trong thanh 
ghi trong PLC. Vui lòng xem hướng dẫn sử dụng về 
các chi tiết của thanh ghi cho PLC được sử dụng.

8 Chạm vào nút [Yes].

“Restoring” sẽ lóe lên trong cột Status.

9 Việc khôi phục dữ liệu trong thiết bị đã kết nối 
sẽ bắt đầu.
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Sau khi hoàn tất khôi phục dữ liệu trong thiết bị đã 
kết nối, hộp thoại thông báo hoàn tất sẽ được hiển 
thị.

10 Chạm vào nút [OK].

11

“Completed” sẽ được hiển thị trong cột Status.

11 Chạm vào nút [Close].

Sau đó, việc khôi phục (GOT→Thiết bị) sẽ được hoàn 
tất.
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Dữ liệu từ/đến các thiết bị đã kết nối sẽ được sao lưu/sửa chữa
Vui lòng tham khảo phần sau đây về các cài đặt loại kết nối và biện pháp phòng ngừa có liên quan đến thiết bị/cáp 
truyền thông và loại kết nối.
→GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1
→GOT2000 Series User’s Manual (Monitor)

Bộ điều khiển Mẫu

RCPU R04CPU, R08CPU, R16CPU, R32CPU, R120CPU

Bộ điều khiển chuyển động CPU (MELSEC iQ-R 
Series)

R16MTCPU, R32MTCPU

QCPU (mẫu Q) Mẫu cơ bản Q00JCPU, Q00CPU, Q01CPU

Mẫu hiệu suất cao Q02CPU, Q02HCPU, Q06HCPU, Q12HCPU, Q25HCPU, Q02PHCPU, 
Q06PHCPU, Q12PHCPU, Q25PHCPU

Mẫu phổ biến Q00UJCPU, Q00UCPU, Q01UCPU, Q02UCPU, Q03UDCPU, 
Q04UDHCPU, Q06UDHCPU, Q10UDHCPU, Q13UDHCPU, 
Q20UDHCPU, Q26UDHCPU, Q03UDECPU, Q04UDEHCPU, 
Q06UDEHCPU, Q10UDEHCPU, Q13UDEHCPU, Q20UDEHCPU, 
Q26UDEHCPU, Q50UDEHCPU, Q100UDEHCPU, Q03UDVCPU, 
Q04UDVCPU, Q06UDVCPU, Q13UDVCPU, Q26UDVCPU

Bộ điều khiển chuyển động CPU (Sê-ri Q) Q172CPU, Q173CPU, Q172HCPU, Q173HCPU, Q172DCPU, 
Q172DCPU-S1, Q173DCPU, Q173DCPU-S1, Q172DSCPU, 
Q173DSCPU, Q170MCPU, Q170MCPU-S1, Q170MSCPU, 
Q170MSCPU-S1

LCPU L02CPU, L06CPU, L26CPU, L26CPU-BT, L26CPU-PBT, L02CPU-P, 
L02SCPU

FXCPU FX0, FX0S, FX0N, FX1, FX2, FX2C, FX1S, FX1N, FX1NC, FX2N, FX2NC, FX3U, 
FX3UC, FX3G

CNC C80 R16NCCPU

CNC C70 Q173NCCPU

Sê-ri MELSERVO-J4 MR-J4-GF

Sê-ri FREQROL-A Sê-ri FREQROL-A800, Sê-ri FREQROL-A800 Plus

Bộ điều khiển rô bốt CRnQ-700, CR750-Q, CR751-Q, CRnD-700, CR750-D, CR751-D
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(1) Loại báo động
GOT có 2 loại chức năng báo động.

(a) Báo động hệ thống
Chức năng này hiển thị một mã lỗi và một thông báo lỗi khi có một lỗi xảy ra trong GOT, trong bất kỳ mạng và 
thiết bị đã kết nối.

Lỗi
xảy ra

400 The communication 

with CPU failed. 16:40:30

9  AC down has been detected.

803 The transient error has occurred.

(b) Báo động người sử dụng
Chức năng này hiển thị một cảnh báo do người sử dụng tạo ra như một thông báo báo động khi có một báo 
động xảy ra.
Sử dụng chức năng này khi hiển thị một báo động do người sử dụng tạo ra.
Xem hướng dẫn sử dụng sau đây về các chi tiết của báo động người sử dụng.
→GT Designer3(GOT2000) Screen Design Manual

M100: TẮT → BẬT
M101: TẮT → BẬT

Error date and time Comment

Jun. 1, 2013 Fuse error

Jun. 1, 2013 Oil error

Jun. 1, 2013 Temperature anomaly

Detail

Touch

Error date and time Comment

May 1, 2004 Fuse error

May 1, 2004 Oil error

May 1, 2004 Temperature anomaly

Detail

Replace the fuse of 

the power supply unit.

4.3 BÁO ĐỘNG
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4.3.1 Kiểm tra báo động hệ thống

(1) Trình tự kiểm tra báo động hệ thống

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [System alarm] trên màn hình 
[Maintenance] trong [Utility main menu].

Mã lỗi
Thông báo lỗi

Cửa sổ báo động hệ thống sẽ được hiển thị.
Vui lòng tham khảo những điều sau đây về báo 
động hệ thống: (Trang PHỤ LỤC 1-1 trong văn 
bản này)
→  PHỤ LỤC 1 CÁC MÃ LỖI VÀ DANH SÁCH BÁO 

ĐỘNG HỆ THỐNG
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(2) Cài lại hiển thị báo động hệ thống
1 Loại bỏ từng nguyên nhân khiến cho báo động 

hệ thống xảy ra.
Có thể xác định các nguyên nhân bằng mã lỗi, 
thông báo lỗi và kênh số hiển thị trên Màn hình 
báo động hệ thống.
→  PHỤ LỤC 1 CÁC MÃ LỖI VÀ DANH SÁCH BÁO 

ĐỘNG HỆ THỐNG

2

2 Chạm vào nút [Reset] để cài lại các báo động hệ 
thống.
Tuy nhiên, nếu không loại bỏ nguyên nhân gây 
ra báo động hệ thống, hiển thị báo động hệ 
thống sẽ không mất đi ngay cả khi thực hiện 
bấm nút reset. Kiểm tra lại hệ thống.
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Pin được sử dụng để giữ các dữ liệu SRAM, dữ liệu đồng hồ, và dữ liệu sao lưu của dữ liệu ghi lại về trạng thái hệ thống.
Nên thay thế pin định kỳ.
Xem phần sau đây về những chi tiết của việc hiển thị trạng thái pin. (Trang 4-28 trong văn bản này)
→ 4.4.3 Kiểm tra điện áp pin

Lắp pin vào GOT trước lần khởi động đầu tiên.
Trình tự lắp và tháo pin như ví dụ về GT27 được trình bày dưới đây. (Phía sau GOT được đặt hướng lên trên như trong 
hình minh hoạ)

Điểm lưu ý

(1) Pin

GT27 đi kèm với pin trong hộp gắn pin. Kết nối đầu nối pin với đầu nối GOT trước khi sử dụng GT27.

 

(2) thời gian thay pin

Để thay pin, để yên GOT hơn 10 phút trước khi thay pin. Thay pin trong vòng 5 phút.

Trình tự lắp pin sẽ khác nhau tùy theo mẫu GOT.

 ● GT2715, GT2712, GT2710
Sau đây cho thấy trình tự lắp pin với việc lấy GT2712 làm ví dụ.

1 Đảm bảo nguồn GOT đã tắt.

Nắp pin 2 Lắp pin vào mặt sau GOT.
Mở nắp pin như bên trái.

3 Tháo pin cũ, và sau đó ngắt kết nối với đầu nối 
để thay pin.

4.4 PIN
4.4.1 Lắp pin
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 ● Không có cáp mở rộng pin

Nắp pin

Không có cáp mở rộng pin

Pin Đầu nối

Cáp đen

Cáp đỏ

4 Đầu nối GOT phụ thuộc vào việc GOT có cáp 
mở rộng pin hay không.
•  Không có cáp mở rộng pin 

Chèn đầu nối pin vào đầu nối GOT.
•  Có cáp mở rộng pin 

Chèn đầu nối pin vào đầu nối mở rộng pin của 
GOT.

Mẫu GT27 với các phiên bản phần cứng sau 
đây không có cáp mở rộng pin.
•  GT2715: Phiên bản G hoặc những phiên bản 

sau đó (được sản xuất vào tháng 9/2014)
•  GT2712: Phiên bản M hoặc những phiên bản 

sau đó (được sản xuất vào tháng 9/2014)
•  GT2710: Phiên bản N hoặc những phiên bản 

sau đó (được sản xuất vào tháng 9/2014)

 ● Có cáp mở rộng pin

Nắp pinCáp mở rộng pin

Pin

Cáp đen

Cáp đỏ

Cáp đỏ

Đầu nối

Cáp đen

Nắp pinPin

Đầu nối

5 Sau khi lắp pin vào hộp gắn pin của GOT, đóng 
nắp pin cho đến khi vào khớp.



4-23

4

6 Bật GOT lên.

7 Kiểm tra xem điều kiện pin có bình thường với 
utility không.
Tham khảo phần sau đây về những chi tiết của 
việc hiển thị điều kiện pin. (Trang 4-28 trong 
văn bản này)
→ 4.4.3 Kiểm tra điện áp pin

 ● GT2708, GT2705

Sau đây cho thấy trình tự lắp pin với việc lấy GT2708 làm ví dụ.

1 Đảm bảo nguồn GOT đã tắt.

Nắp thẻ SD 2 Lắp pin vào trong nắp thẻ SD trên mặt phụ của 
GOT.
Mở nắp thẻ SD như hình bên trái.

3 Tháo pin cũ, và sau đó ngắt kết nối với đầu nối.
Vui lòng tham khảo phần sau đây về thông tin 
làm thế nào để tháo pin.

Nắp thẻ SD

Pin

Đầu nối

Cáp đen

Cáp đỏ

4 Chèn đầu nối pin với đầu nối GOT.
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Nắp thẻ SDPin

Đầu nối

5 Sau khi lắp pin vào hộp gắn pin của GOT, đóng 
nắp thẻ SD cho đến khi vào khớp.

6

7

Bật GOT lên.

Kiểm tra xem điều kiện pin có bình thường với 
utility không.
Tham khảo phần sau đây về những chi tiết của 
việc hiển thị điều kiện pin. (Trang 4-28 trong 
văn bản này)
→ 4.4.3 Kiểm tra điện áp pin
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Trình tự tháo pin sẽ khác nhau tùy theo mẫu GOT.

 ● GT2715, GT2712, GT2710
Sau đây cho thấy trình tự tháo pin với việc lấy GT2712 làm ví dụ.

1 Đảm bảo nguồn GOT đã tắt.

Nắp pinPin

Đầu nối

2 Pin được khôi phục ở mặt sau GOT.
Mở nắp pin như bên trái.

 ● Không có cáp mở rộng pin

Nắp pin

Pin Đầu nối

Cáp đen

Cáp đỏ

3 Sau khi tháo pin khỏi hộp gắn pin của GOT, rút 
đầu nối.
Đầu nối phụ GOT phụ thuộc vào việc GOT có 
cáp mở rộng pin hay không.
•  Không có cáp mở rộng pin 

Rút đầu nối pin khỏi đầu nối GOT.
•  Có cáp mở rộng pin 

Rút đầu nối pin khỏi đầu nối cáp mở rộng pin 
của GOT.

Mẫu GT27 với các phiên bản phần cứng sau 
đây không có cáp mở rộng pin.
•  GT2715: Phiên bản G hoặc những phiên bản 

sau đó (được sản xuất vào tháng 9/2014)
•  GT2712: Phiên bản M hoặc những phiên bản 

sau đó (được sản xuất vào tháng 9/2014)
•  GT2710: Phiên bản N hoặc những phiên bản 

sau đó (được sản xuất vào tháng 9/2014)

4.4.2 Tháo pin
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 ● Có cáp mở rộng pin

Nắp pinCáp mở rộng pin

Pin

Cáp đen

Cáp đỏ

Cáp đỏ

Đầu nối

Cáp đen

Nắp pin 4 Đẩy và đóng nắp pin cho đến khi vào khớp.
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 ● GT2708, GT2705
Sau đây cho thấy trình tự tháo pin với việc lấy GT2708 làm ví dụ.

1 Đảm bảo nguồn GOT đã tắt.

Nắp thẻ SDPin

Đầu nối

2 Pin được khôi phục trong nắp thẻ SD trên mặt 
phụ của GOT.
Mở nắp thẻ SD như hình bên trái.

Nắp thẻ SD

Pin

Đầu nối

Cáp đen

Cáp đỏ

3 Sau khi tháo pin khỏi hộp gắn pin của GOT, rút 
đầu nối pin khỏi đầu nối GOT.

Nắp thẻ SD 4 Đóng nắp thẻ SD cho đến khi vào khớp.
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Có thể kiểm tra điện áp pin theo 2 phương pháp.
● Kiểm tra menu utility
● Kiểm tra màn hình báo động hệ thống

(1) Phương pháp kiểm tra trên menu utility

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [Time] trên màn hình [GOT basic set] 
trong [Utility main menu].

Hiển thị trạng thái điện áp pin.

Hiển thị Trạng thái

Normal Bình thường

Low/None Tụt điện áp hoặc không có pin cài 

đặt

Lập tức thay pin khi điện áp pin thấp.
GOT giữ lại dữ liệu trong 14 ngày sau khi phát 
hiện pin ở điện áp thấp. Tuy nhiên, sau thời 
gian đó, GOT không thể giữ lại dữ liệu.

4.4.3 Kiểm tra điện áp pin
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(2) Cài đặt phương pháp hiển thị trên màn hình báo động hệ thống

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [Display] trên màn hình [GOT basic 
set] trong [Utility main menu].

3

4

3 Chạm vào [Battery alarm display], và cài đặt sẽ 
thay đổi. (BẬT ⇔ TẮT) 
Cài đặt [ON].

4 Chạm vào nút [OK] để khởi động lại GOT và 
phản ánh thay đổi cài đặt.
Chạm vào nút [Cancel] để hủy thay đổi cài đặt 
và quay trở lại menu chính.



4-30

 ● Kiểm tra màn hình báo động hệ thống

Khi phát hiện việc giảm điện áp pin, cửa sổ như 
bên trái sẽ được hiển thị.
Thay pin ngay lập tức.
GOT giữ lại dữ liệu trong 14 ngày sau khi phát 
hiện pin ở điện áp thấp. Tuy nhiên, sau thời 
gian đó, GOT không thể giữ lại dữ liệu.
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PHỤ LỤC

PHỤ LỤC 1 CÁC MÃ LỖI VÀ DANH SÁCH BÁO 

ĐỘNG HỆ THỐNG
(1) Các mã lỗi hiển thị trên GOT

Mã lỗi Nguồn lỗi Mô tả

300 đến 399

GOT

Mã lỗi của chức năng khối chính GOT

400 đến 499 Mã lỗi của chức năng truyền thông GOT

500 đến 699 Mã lỗi của chức năng khối chính GOT

800 đến 999 Mạng Mã lỗi của mạng

(2) Danh sách báo động hệ thống

Mã lỗi Thông báo lỗi Hoạt động

300
Project data contains 
unsupported objects.

Cài đặt phiên bản mới nhất của GT Designer3 và ghi dữ liệu gói lần nữa 
vào GOT.

301
Project data contains 
unsupported functions.

Cài đặt phiên bản mới nhất của GT Designer3 và ghi dữ liệu gói lần nữa 
vào GOT.

302
Project data contains 
unsupported settings.

Cài đặt phiên bản mới nhất của GT Designer3 và ghi dữ liệu gói lần nữa 
vào GOT.

303
Set monitor points too large. 
Decrease setting points.

Giảm số lượng các đối tượng từ màn hình hiển thị. Đối với số lượng các 
đối tượng tối đa cho 1 màn hình, tham khảo sau đây.
→ GT Designer3 (GOT2000) Screen Design Manual

305
Background loading of the 
system package failed.

Kiểm tra lưu trữ dữ liệu, mà lưu trữ dữ liệu gói và dữ liệu project GOT, được 
cài đặt và dữ liệu không bị hư hại.

306
No project data. Download 
screen data.

Dữ liệu project không được tải xuống hoặc dữ liệu màn hình không đủ.
Tải xuống dữ liệu project hoặc dữ liệu màn hình.

307 Monitor device not set
Thiết bị giám sát của đối tượng không được thiết lập.
Cài đặt thiết bị giám sát của đối tượng.

308
No comment data. Download 
comment.

Tập tin ghi chú không tồn tại.
Tạo tập tin ghi chú và tải vào GOT.

309
Device reading error. Correct 
device.

Lỗi xảy ra khi đọc thiết bị liên tục.
Sửa lại thiết bị.

310
Project data does not exist or 
out of range.

Màn hình nền chỉ định/màn hình cửa sổ không tồn tại trong dữ liệu 
project.
Màn hình nền chỉ định/màn hình cửa sổ nằm ngoài vùng cho phép. Chỉ 
định màn hình nền hiện tại/màn hình cửa sổ.

311
No. of alarm has exceeded 
upper limit. Delete restored 
alarm.

Số lịch sử báo động có thể được quan sát bằng chức năng hiển thị lịch sử 
báo động đã vượt quá các điểm lưu ý tối đa.
Xoá lịch sử sửa chữa để giảm số lịch sử báo động.

PHỤ LỤC 
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Mã lỗi Thông báo lỗi Hoạt động

312
No. of sampling has exceeded 
upper limit. Delete collected 
data.

Tần số thu thập vượt quá giới hạn trên khi “Bộ nhớ lưu trữ” và “Tích luỹ/
Trung bình” được cài đặt trong đồ thị phân tán.
•  Chấp thuận cài đặt “Xoá Kích hoạt” trong đồ thị phân tán.
•  Cài đặt “Hoạt động ở tần số theo thời gian” để “Khởi tạo và Tiếp tục” trong 

đồ thị phân tán.

315
Device writing error. Correct 
device.

Lỗi xảy ra khi ghi vào thiết bị.; Sửa lại thiết bị.

316
Cannot display or input 
operation value. Review 
expression.

Trong thông số kỹ thuật gián tiếp của số các bộ phận/chú thích, kết quả 
hoạt động dữ liệu vượt quá phạm vi mà loại thiết bị có thể được thể hiện 
trong đó.
Xem lại sự thể hiện hoạt động dữ liệu, để không vượt quá phạm vi mà loại 
thiết bị có thể được thể hiện trong đó.

317
Too high frequency of data 
collection.
Review conditions.

Dữ liệu của đối tượng, mà được cài đặt [Collect data only when trigger 
conditions are satisfied], được thu thập quá thường xuyên, hoặc số lượng 
các đối tượng vượt quá số lượng các đối tượng có thể thu thập cùng một 
lúc.
• Cài đặt chu kỳ dài hơn cho xuất hiện kích hoạt với từng đối tượng.
•  Thực hiện các thiết lập để 257 hoặc các kích hoạt hiển thị nhiều hơn của 

các đối tượng, không xảy ra cùng một lúc, mà [Collect data only when 
trigger conditions are satisfied] được cài đặt.

320
Specified object does not exist 
or out of range.

Tập tin bộ phận không tồn tại.
Tạo tập tin bộ phận và tải vào GOT.

322
Dedicated device is out of 
range.
Confirm device range.

Biến số được giám sát nằm ngoài vùng cho phép của PLC CPU được nhắm 
tới.
Cài đặt biến số trong phạm vi mà có thể được theo dõi bằng PLC CPU 
giám sát và các cài đặt tham số.

326
Label data types do not match.
Confirm the label setting.

•  Kiểu dữ liệu của thiết bị được chỉ định vào nhãn là không chính xác. 
Đối với kiểu dữ liệu có sẵn của các nhãn chung, tham khảo theo sau đây. 
→ GT Designer3 (GOT2000) Screen Design Manual

•  Kiểu dữ liệu của các biến đối tượng hoặc các dữ liệu khác và các nhãn 
gắn trên phía PLC là không thống nhất. 
Sửa lại kiểu dữ liệu của các đối tượng hoặc các dữ liệu khác theo như các 
nhãn gắn trên phía PLC.

•  Giá trị hằng số được cài đặt cho nhãn.; Trong thiết lập đối tượng, không 
sử dụng nhãn ở nơi mà giá trị hằng số được cài đặt.

•  Biến loại 64-bit được chỉ định vào nhãn. 
Không sử dụng nhãn loại 64-bit trong cài đặt thiết bị.

327
Label names have not been 
resolved. Resolve label names 
again.

Kiểm tra trạng thái kết nối của PLC và thực hiện lại độ phân giải tên nhãn.
→ GT Designer3 (GOT2000) Screen Design Manual



PHỤ LỤC 1-3
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Mã lỗi Thông báo lỗi Hoạt động

328
Label setting error. Confirm the 
label setting.

•  Nhãn được gắn cho PLC mà không hỗ trợ các nhãn. 
Sửa lại số mạng và số trạm.

•  Tên nhãn được chỉ định trong dữ liệu project không tồn tại trên phía PLC. 
Kiểm tra nếu tên nhãn được chỉ định trong dữ liệu project tồn tại trên 
phía PLC.

•  GOT truy cập vào nhãn không thể tiếp cận từ các thiết bị ngoại vi. 
Cho phép truy cập từ các thiết bị ngoại vi trong thiết lập nhãn trên phía 
PLC.

•  Khi một nhãn chung của cấu trúc có các thành phần mà các biến được 
gắn thủ công, GOT sẽ không thực hiện độ phân giải tên nhãn. 
Thực hiện các hoạt động để các biến được chỉ định tự động vào các 
thành phần, hoặc cài đặt trực tiếp các biến được chỉ định thủ công như 
các biến giám sát.

329
Station No. switching does not 
support labels.

Không thực hiện chuyển đổi trạm số thành trạm sử dụng nhãn.

330
Insufficient memory media 
capacity.
Confirm M-card capacity.

Dung lượng có sẵn trong thẻ nhớ không đủ.
Kiểm tra dung lượng có sẵn của thẻ nhớ.; Về phương pháp kiểm tra, tham 
khảo theo sau đây.
→ GT Designer3 (GOT2000) Screen Design Manual

331
Memory card not installed or 
MCARD switched OFF.

Thẻ nhớ không được lắp đặt trong ổ đĩa, hoặc nắp thẻ SD đã bị mở.
• Lắp thẻ nhớ vào ổ đĩa chỉ định.
• Đóng nắp thẻ SD để thẻ SD có thể được truy cập.

332
Memory media is not 
formatted.

Thẻ nhớ (cài sẵn thẻ SD) không được định dạng hoặc định dạng không 
chính xác.
Định dạng thẻ nhớ.

333
Unable to overwrite. Memory 
card is write-protected.

Thẻ nhớ (cài sẵn thẻ SD) được bảo vệ ghi.
Huỷ bảo vệ ghi của thẻ nhớ.

334
Memory media error. Replace 
memory media.

Thẻ nhớ (cài sẵn thẻ SD) bị lỗi.
Thay thế thẻ nhớ.

336
The target file size is too large 
to be accessed.

•  Kiểm tra nếu kích thước tập tin mà GOT cố gắng truy cập lớn hơn 2 GB.
• Kiểm tra kích thước của tập tin hình ảnh là 300 KB hay nhỏ hơn.

337
File output failed. Confirm 
output file path.

Một trong thư mục hoặc tập tin sau đây với tên giống như tập tin được 
tạo tồn tại trong đích lưu trữ thẻ SD hoặc bộ nhớ USB.
• Thư mục lưu trữ dữ liệu
• Tập tin bảo vệ ghi
Xoá các thư mục hoặc tập tin trên, hoặc đổi tên tập tin được tạo.

338
Modem is not connected 
correctly or the power is not 
turned on.

Không có phản hồi với lệnh khởi tạo vì mô đem không được kết nối chính 
xác hoặc nguồn điện chưa được bật.
• Xác nhận kết nối mô đem.
• Bật nguồn điện của mô đem.
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339
Failed to initialize the modem. 
Check initialization command.

Lỗi bị trả về từ mô đem vì lệnh khởi tạo không hợp lệ.
• Xác nhận lệnh khởi tạo của mô đem.

340 Printer error or power failure
Máy in bị lỗi hoặc chưa bật nguồn điện cung cấp cho máy in.
• Xác nhận máy in.
• Bật nguồn cung cấp điện cho máy in.

342
External power is not supplied 
to external I/O unit.

Lỗi xảy ra tại thay thế mô đun kết nối I/O bên ngoài.
•  Nếu nguồn điện bên ngoài (24 V DC) không được cung cấp, cung cấp 

nguồn điện bên ngoài.
•  Nếu nguồn điện bên ngoài được cung cấp, thay thế mô đun kết nối I/O 

bên ngoài.

343
External I/O unit installation 
error.
Check if firmly installed.

Mô đun kết nối I/O bên ngoài không được lắp đặt chính xác.
Lắp đặt mô đun kết nối I/O bên ngoài chính xác.

345
BCD/BIN conversion error 
Correct data

Bất kỳ giá trị nào không thể được chuyển đổi sang giá trị BCD/BIN đang 
được hiển thị/nhập vào.
• Thay đổi dữ liệu biến được hiển thị sang giá trị BCD.
• Sửa lại giá trị đầu vào thành 4 chữ số nguyên.

360
0 divisor division error. Confirm 
operation expression.

Lỗi chia cho 0 xảy ra trong quá trình tính toán dữ liệu.
Xem lại sự công thức tính toán dữ liệu để số chia không trở thành 0.

361
Specified device No. is out of 
range.

Số tập tin đã nhập nằm ngoài phạm vi. Kiểm tra số tập tin đã nhập, và 
nhập giá trị hợp lệ (1 đến 9999).

362
Invalid device value in time 
action setting

Khi bộ điều khiển được kiểm soát với chức năng thời gian hoạt động của 
GOT, số cài đặt nằm ngoài phạm vi, hoặc giá trị thiết bị cài đặt liên quan 
đến cài đặt vận hành nằm ngoài phạm vi hoặc không hợp lệ.
Cài đặt giá trị hợp lệ.

363
The file number exceeds the 
limitation. File output failed.

Xoá tập tin mà có tập tin lớn nhất mang số và các tập tin không cần thiết.

370
Upper and lower limit value 
error.
Confirm value setting.

Cài đặt giá trị giới hạn dưới/trên là [Upper limit < Lower limit].
Sửa lại thiết lập để thành “Giới hạn trên Giới hạn dưới”.

380
Insufficient USB drive capacity.
Confirm the drive capacity.

Bộ nhớ có sẵn của ổ đĩa mở rộng không đủ.
Xác nhận bộ nhớ có sẵn của ổ đĩa mở rộng, và tăng bộ nhớ nếu nó ít.

381
USB drive is not installed or in a 
removable state.

Lắp đặt ổ đĩa mở rộng nếu nó chưa được lắp vào.
Lắp đặt lại ổ đĩa mở rộng nếu nó đang ở trạng thái có thể tháo ra được.

382 USB drive is not formatted.
Ổ đĩa mở rộng không được định dạng hoặc được định dạng không tương 
thích với GOT.
Định dạng lại ổ đĩa mở rộng.

383
Unable to overwrite. USB drive 
is write-protected

Ổ đĩa mở rộng được bảo vệ ghi.
Huỷ bảo vệ ghi của ổ đĩa mở rộng.
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384
USB drive error. Replace USB 
drive.

Ổ đĩa mở rộng bị lỗi.
Thay thế ổ đĩa mở rộng.

401
An error response has been 
received from the connected 
device.

• Loại ra nguyên nhân của lỗi CPU.
•  Xem lại các điều kiện vận hành của CPU, các tham số, và các điều kiện 

khác.

402
Communication timeout. 
Confirm communication 
pathway or modules.

Lỗi hết thời gian đã xảy ra trong khi liên lạc.
•  Xác nhận mất kết nối cáp, trạng thái gắn mô đun truyền thông và trạng 

thái của PLC. 
Kênh số không được hiển thị trong mã lỗi hoặc thông báo lỗi trong 
trường hợp lỗi xảy ra khi sử dụng chức năng đa kênh. 
Tham khảo hướng dẫn sau đây để nhận dạng kênh số đang bị lỗi. 
→  GOT2000 Series Connection Manual for GT Works3 and a controller 

used (1.6 Checking for Normal Monitoring)
•  Lỗi này có thể xảy ra khi lượng tải của PLC CPU trở nên nặng hơn trong 

khi đang truy cập các trạm khác. Trong trường hợp như vậy, truyền dữ 
liệu của trạm khác sang trạm chủ PLC CPU và giám sát chúng tại máy 
chủ.

• Đặt lệnh COM khi thời gian quét PLC dài.
•  Kiểm tra nếu phiên bản của trình điều khiển giao tiếp hỗ trợ bộ điều 

khiển. 
Để kiểm tra phiên bản của trình điều khiển giao tiếp, tham khảo sau đây. 
→ GT Designer3 (GOT2000) Screen Design Manual

403
SIO status error. Confirm 
communication pathway or 
modules.

Một trong các lỗi tràn số, lỗi bit chẵn lẻ hoặc lỗi bắt cháy được sinh ra khi 
nhận được liên lạc RS-422/RS-232.
Xác nhận mất kết nối cáp, trạng thái gắn mô đun truyền thông, trạng thái 
của PLC, và tốc độ truyền của liên kết máy tính.
Kênh số không được hiển thị trong mã lỗi hoặc thông báo lỗi trong trường 
hợp lỗi xảy ra khi sử dụng chức năng đa kênh.
Tham khảo hướng dẫn sau đây để nhận dạng kênh số đang bị lỗi.
→  GOT2000 Series Connection Manual for GT Works3 and a controller 

used (1.6 Checking for Normal Monitoring)

404
Response does not match 
communication request.

• Giải quyết sự nhiễu chéo trên tuyến.
• Kéo dài thời gian hết thời gian liên lạc.

406
Specified station access is out 
of range. Confirm station no.

•  Các số trạm khác hơn trạm chính/cục bộ được chỉ định tại kết nối CC-Link 
(theo G4).

•  Một PLC CPU khác hơn QCPU được truy cập.; Xác nhận số trạm của dữ 
liệu project.
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407
Accessed other network. 
Change network setting.

•  Khi giám sát mạng tương tự như GOT; GOT truy cập các mạng khác với 
MELSECNET/H, MELSECNET/10 (PLC đến mạng PLC), hoặc kết nối Mạng 
Bộ điều khiển IE CC-Link. Xác nhận số mạng của dữ liệu project để không 
truy cập vào các mạng khác.

•  Khi giám sát các mạng khác; Cấu hình lại [Routing Information Setting] 
của GT Designer3 hoặc [Routing Information Setting] của GX Developer.

•  Khi sử dụng GT15-75J71LP23-Z/GT15-75J71BR13-Z; Các mạng khác 
không thể được giám sát.; Xác nhận số mạng của dữ liệu project để 
không truy cập vào các mạng khác.

410
Cannot perform operation 
because of PLC run mode. Stop 
the PLC.

Thao tác, mà không thể được thực hiện trong RUN của PLC CPU, đã được 
thực hiện.
Dừng PLC CPU.

411
Memory cassette is 
write-protected.
Check the memory cassette.

Băng bộ nhớ được lắp đặt trong PLC CPU là EPROM hoặc E2PROM, và 
đang trong trạng thái được bảo vệ.
Xác nhận băng bộ nhớ đã lắp vào PLC CPU.

412
Cannot read/write device 
protected by keyword. Remove 
keyword.

Từ khoá được cài trong PLC CPU.
Xoá từ khoá.

413
Unsupported CPU has been 
accessed.

• Kiểm tra hướng dẫn mới nhất để thấy nếu CPU được hỗ trợ.
• Ghi dữ liệu gói được tạo ra với phiên bản mới nhất của GT Designer3.

420 E71 specification is ASCII.
[ASCII code] được chọn trong [Ethernet operations] của thiết lập phía PLC.
Chọn [Binary code].

421
E71 is set as read-only. Clear 
setting.

Mô đun kết nối Ethernet trên phía PLC được cài đặt chỉ đọc.
Cài đặt mô đun kết nối Ethernet trên phía PLC thành cho phép ghi.

422
Not communicating between 
CPU and E71. Confirm CPU 
error.

Lỗi PLC CPU. Liên lạc giữa PLC CPU và mô đun kết nôi Ethernet phía PLC là 
không thể.
Xác nhận có hay không lỗi trong PLC CPU bằng GX Developer, v.v... (Xác 
nhận bộ nhớ đệm)

423
Insufficient network table 
information.
Add station no.

Số trạm đặt trong dữ liệu project và số trạm đặt trong thiết bị trạm số 
chuyển đổi không tồn tại trong thiết lập Ethernet của GT Designer3.
•  Thêm số trạm đặt trong dữ liệu project vào thiết lập Ethernet của GT 

Designer3.
•  Khi sử dụng chức năng chuyển đổi trạm số, kiểm tra dữ liệu của thiết bị 

trạm số chuyển đổi. 
Khi số trạm được chỉ định trong thiết bị trạm số chuyển đổi không được 
đặt trong thiết lập Ethernet, thêm số trạm vào thiết lập Ethernet. 
Khi số trạm không tồn tại trong hệ thống, thay đổi dữ liệu của thiết bị 
trạm số chuyển đổi. (Cài đặt trạm số để nó trở nên tương tự trạm số 
của đơn vị Ethernet phía PLC được đặt trong thiết lập thông số của GX 
Developer.)
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424

Same sta. on GOT & project 
data. 
Review communication 
parameter.

Trạm số đặt trong utility của GOT tương tự với trạm số đặt trong thiết lập 
Ethernet của GT Designer3 (số trạm của mô đun Ethernet phía PLC) hoặc 
trong dữ liệu project.
Kiểm tra các nội dung sau đây để các số nhiều trạm không giống nhau.
• Kiểm tra số trạm của GOT trong utility GOT.
• Kiểm tra số trạm đặt trong dữ liệu project.
•  Kiểm tra số trạm đặt trong thiết lập Ethernet. (Cài đặt trạm số để nó trở 

nên tương tự trạm số của mô đun Ethernet phía PLC được đặt trong thiết 
lập thông số của GX Developer.)

•  Khi sử dụng chức năng chuyển đổi trạm số, kiểm tra dữ liệu của thiết bị 
trạm số chuyển đổi.

425
A duplicate IP address has been 
detected. Confirm the setting.

GOT có địa chỉ IP giống với một thiết bị khác.
Thay đổi địa chỉ IP của GOT hoặc thiết bị.

430
Wireless LAN unit is not 
mounted or a hardware error 
occurred.

Mô đun truyền thông mạng LAN không dây không được cài đặt trên giao 
diện bên.
Kiểm tra rằng mô đun được cài đặt đúng.

431
Connectable access point is not 
found.

Kiểm tra thiết lập cho điểm truy cập dễ tiếp cận và thiết lập kết nối mạng 
LAN không dây.

432
Wireless LAN connection 
settings are not specified.

Sau khi tạo cấu hình thiết lập kết nối mạng LAN không dây, bật chức năng 
kết nối mạng LAN không dây.
→ GT Designer3 (GOT2000) Screen Design Manual

433
Failed to authenticate the 
access point.

Kiểm tra nếu phương pháp xác thực được chỉ định trong thiết lập kết nối 
mạng LAN không dây tương tự với bên điểm truy cập.

434
GOT hardware version not 
supported by wireless LAN 
connection

Sử dụng GOT với phiên bản B phần cứng hoặc mới hơn.
Để kiểm tra phiên bản phần cứng, tham khảo sau đây.
→ GOT2000 Series User’s Manual (Hardware)

440
The label information has been 
updated.

Giải pháp tên nhãn sẽ được thực hiện tự động.
Chờ hoàn tất.

441
The specified CPU is updating 
the label information.

Thông tin nhãn chung của CPU được chỉ định sẽ được cập nhật.
Chờ hoàn tất.

442
Resolving the label information.
Do not turn off the power 
during the process.

Giải pháp tên nhãn đang được thực hiện.
Chờ hoàn tất.

448
PLC cannot handle as 
requested.
Correct devices.

Biến ngoài phạm vi của các thanh ghi tập tin PLC CPU và bộ nhớ đệm đã 
được chỉ định.
Sửa lại biến giám sát bằng cách cài đặt thanh ghi tập tin của PLC CPU.

449
Dedicated device is out of 
range.
Confirm device range.

Cài đặt địa chỉ cho mô đun chức năng đặc biệt trong phạm vi có sẵn giám 
sát GOT.
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450
Path has changed or timeout 
occurred in redundant system.

Đường dẫn đã được chuyển đổi hoặc hết thời gian đã xảy ra trong hệ 
thống dự phòng.
• Kiểm tra PLC CPU để biết nếu đường dẫn đã được chuyển đổi.
•  Kiểm tra trạng thái kết nối cáp, trạng thái cài đặt mô đun truyền thông, 

và trạng thái PLC CPU.
•  Lỗi này có thể xảy ra khi lượng tải của PLC CPU trở nên nặng hơn trong 

khi đang truy cập các trạm khác. Trong trường hợp như vậy, truyền dữ 
liệu của các trạm khác sang trạm chủ PLC CPU và giám sát chúng tại máy 
chủ.

•  Thực hiện một trong các thao tác sau đây nếu thời gian quét PLC dài: Đặt 
lệnh COM/Phần mở rộng của xử lý END/Thiết lập của số lần xử lý cho dữ 
liệu chung/Quá trình cập nhật dữ liệu hàng loạt.

451
Q redundant system settings 
and current config. Do not 
match.

Thay đổi thiết lập dự phòng Q thích hợp với hệ thống CPU dự phòng Q 
thật.

460 Communication unit error
• Cài lại nguồn của GOT.
• Thay thế thiết bị.

461
Communication error occurred 
between option units and the 
GOT.

Kiểm tra hướng dẫn sau cho thông số kỹ thuật kháng rung và phương 
pháp gắn thiết bị tuỳ chọn.
Sau đó, cài lại nguồn cấp GOT.
→ GOT2000 Series User’s Manual (Hardware)

470
No routing params. 
Communication not 
established with specified sta.

Cài đặt các tham số định tuyến.

471
No IP address info. (Ethernet 
table) of connection 
destination.

Cài đặt thông tin mạng về điểm đến cho [Ethernet setting].

480
Communication channel not 
set. Set channel number on 
Utility.

Kênh (kênh số 1 đến 4) để giao tiếp với bộ điều khiển không được cài.
•  Sau khi thiết lập các Thiết lập Giao tiếp trên GT Designer3, tải về GOT.
•  Thay đổi phân bổ kênh trong các Thiết lập Giao tiếp trên utility.

481
Communication unit not 
mounted to the slot of active 
channel.

Giao diện mà kênh (Kênh số 1 đến 4) được cài không có mô đun truyền 
thông được cài đặt.
•  Cài đặt mô đun truyền thông vào giao diện nơi kênh (Kênh số 1 đến 4) 

được cài.
•  Thay đổi sự phân bổ kênh (Kênh số 1 đến 4) trong Thiết lập Giao tiếp.

482
Too many same units are 
mounted.
Confirm the no of units.

Các mô đun được gắn trên GOT vượt quá số lượng tối đa của các mô đun 
có thể gắn.
Kiểm tra số lượng các mô đun, và bỏ các mô đun không cần thiết.

483
Simultaneous mounting of the 
units are not allowed.

Không cho phép gắn hai hoặc nhiều hơn mô đun cùng lúc trên GOT.
Kiểm tra các mô đun được gắn, và bỏ các mô đun không cần thiết.
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484
Unit mounted incorrectly. Move 
the unit to correct position.

Mô đun không được gắn vào vị trí đúng trên GOT.
Xác nhận vị trí gắn của mô đun.

485
Too many units mounted on 
GOT.
Reduce units.

Các mô đun được gắn trên GOT vượt quá số lượng tối đa của các mô đun 
có thể gắn.
Kiểm tra số lượng các mô đun và bỏ các mô đun không cần thiết.

486
Communication unit 
not corresponded to set 
communication driver.

Trình điều khiển giao tiếp cài trong Thiết lập Giao tiếp và mô đun truyền 
thông được cài đặt trên GOT không khớp nhau.
•  Kiểm tra xem trình điều khiển giao tiếp cài trong Thiết lập Giao tiếp là 

đúng.
•  Kiểm tra xem có bất kỳ mô đun truyền thông nào không đúng được cài 

đặt trên GOT.

487
Please turn on the PLC and the 
GOT again.

Bật nguồn của PLC và GOT lần nữa.

488
Too many units mounted on 
GOT.
Reduce units.

Các mô đun được gắn trên GOT vượt quá số lượng tối đa của các mô đun 
có thể gắn. Kiểm tra số lượng các mô đun, và bỏ các mô đun không cần 
thiết.

489
Inactive channel has been 
selected at Communication 
Settings.

Kênh số không hoạt động sẽ được cài đặt trong dữ liệu project.
•  Kiểm tra xem có bất kỳ kênh số nào không cần thiết được cài trong dữ 

liệu project.
•  Kiểm tra xem các kênh số được cài trong dữ liệu project có được cài 

trong các Thiết lập Giao tiếp.

492
Unusable communication units 
are mounted.

Mô đun không dùng được cho GOT được cài.
Bỏ mô đun không dùng được.

493
Installation of extension units 
may be inappropriate.

Kiểm tra nếu các mô đun mở rộng được gắn chắc chắn trên GOT.

497
Failed to start communication 
driver(s).

Cài đặt (các) trình điều khiển giao tiếp lại.

500
Warning! Built-in battery 
voltage is low.

Điện áp của pin cài sẵn GOT bị giảm.
Thay thế pin cài sẵn GOT.

506
Warning! Backlight needs 
replacement.

GS chuyên dụng thông báo rằng nguồn đèn nền đã đạt tới thời gian cài 
đặt hoặc hơn.
Vui lòng hỏi ý kiến trung tâm dịch vụ Mitsubishi nội địa hoặc văn phòng 
đại diện.
GOT có thể được sửa chữa bằng cách thực hiện chức năng cài lại thêm số 
lần. GOT cũng có thể được sửa chữa bằng cách tắt tín hiệu thông báo thủ 
công. Trong trường hợp như vậy, TẮT sau khi thiết lập thêm số lần lớn hơn.

510 Clock data input out of range

Nhập giá trị dữ liệu đồng hồ nằm ngoài phạm vi cho phép nhập.
Trong trường hợp này, giá trị nhập không được chấp nhận.
Xác nhận phạm vi nhập của giá trị sẽ nhập như dữ liệu đồng hồ, và nhập 
giá trị thích hợp lần nữa.
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522
Unnecessary file deleted to 
create new file.

Tập tin cũ của các nội dung khác nhau đã được xoá và một tập tin mới đã 
được tạo.
Lưu ý rằng tập tin cũ bị xoá và tập tin mới được tạo nếu tập tin của cùng 
tên với các nội dung khác nhau tồn tại khi tạo các tập tin.

523
The read alarm log file has 
a different number of alarm 
points.

Khi các thiết lập báo động (bao gồm số lượng các báo động được giám 
sát và hệ thống cấp bậc) bị thay đổi, tập tin ghi lại báo động trước khi thay 
đổi sẽ được đọc, nhưng các báo động được thu thập dựa theo các thiết 
lập mới.
Báo động hiển thị sau thay đổi có thể khác với cái trước khi thay đổi.
Xoá tập tin ghi lại báo động nếu cần thiết.

525
Unable to read/write alarm log 
files under different projects.

Không thể đọc tập tin ghi lại báo động được lưu bởi project khác.
Xác nhận tập tin ghi lại báo động và nơi lưu trữ tập tin ghi lại báo động.

526 File conversion failed.
Tập tin được chỉ định cho việc chuyển đổi tập tin không tồn tại.
Kiểm tra các thiết lập cho chỉ định tập tin được chuyển đổi.

527 Insufficient SRAM capacity.
Dung lượng cho vùng người dùng SRAM không đủ.
Xác nhận bộ nhớ có sẵn trong vùng người dùng SRAM.

528
Error in SRAM.
Failed to write data.

Lỗi có thể bị gây ra bởi sự hỏng trong đơn vị chính GOT.
Liên hệ văn phòng đại diện Mitsubishi nội địa của bạn.

529
Data error in SRAM. Check the 
battery life.

Lỗi trong dữ liệu SRAM do điện áp pin yếu, v.v...
Xác nhận trạng thái pin.

532
Cannot access the files.
Check the memory card.

Kiểm tra nếu tên tập tin thích hợp.
Tên tập tin chứa các ký tự không hợp lệ.
Đối với kiểu ký tự và số lượng các ký tự có sẵn cho tên tập tin, tham khảo 
sau đây.
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533
Cannot access Files. Check the 
memory card

•  Cắm thẻ SD hoặc bộ nhớ USB.
•  Đóng nắp thẻ SD để thẻ SD có thể được truy cập.
•  Nếu thẻ SD hoặc bộ nhớ USB có các tập tin không cần thiết, xoá các tập 

tin đó.

535 Cannot open image file. Kiểm tra nếu tập tin đích được lưu trữ trong thẻ SD hoặc bộ nhớ USB.

536
Image file error or invalid file 
format.

•  Xác nhận xem các tập tin hình ảnh trong thẻ SD hoặc bộ nhớ USB là bình 
thường.

•  Xác nhận xem có bất kỳ tập tin hình ảnh nào của định dạng không hợp 
lệ được lưu trữ.

562
Install the font appropriate for 
the specified system language.

Không có phông chữ thích hợp cho ngôn ngữ hệ thống được chỉ định tại 
chuyển đổi ngôn ngữ hệ thống được cài đặt.
Cài đặt phông chữ thích hợp.

565
Files for the extended system 
application are missing.

Cài đặt lại ứng dụng hệ thống (chức năng mở rộng) mà đã thất bại trong 
việc thực hiện.
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571
Capacity shortage of user 
memory (RAM)

Không có dung lượng/vùng trống trong ổ đĩa D.
Định dạng ổ đĩa D trong bộ nhớ để đảm bảo vùng còn trống.

577
Newly readable records do not 
exist.

Dung lượng để đọc các hồ sơ không đủ.
Xoá các hồ sơ không cần thiết.

578
The specified record name is 
invalid.
Check the record name.

Một hồ sơ trống không có tên và giá trị thiết bị không tồn tại.
Cài đặt một hồ sơ trống trước.

579
Recipe is in process. Cannot 
operate the recipe file.

Đang trong quá trình xử lý một công thức khác.
Sau khi xử lý hoàn tất, thực hiện vận hành tập tin công thức lần nữa.

580
Selected recipe setting is not 
the recipe file operation target.

Thiết lập công thức chỉ định không có tập tin công thức G2P.
Chỉ định tập tin G2P.

581 Abnormal Advanced recipe file
Công thức không thể được thực hiện cho tập tin công thức với nội dung 
không đúng. Xoá tập tin công thức từ thẻ SD hoặc bộ nhớ USB.

582
Cannot generate Advanced 
recipe file.

Không thể khởi động tập tin công thức. Xác nhận theo sau đây và thực 
hiện xử lý công thức lần nữa.
• Xác nhận xem đã lắp đặt thẻ SD hoặc bộ nhớ USB chưa.
• Đóng nắp thẻ SD để thẻ SD có thể được truy cập.
• Xác nhận bộ nhớ có sẵn của thẻ SD hoặc bộ nhớ USB.

583
Unable to save device value to 
Advanced recipe file.

Không thể lưu giá trị biến vào tập tin công thức.
• Xác nhận việc bảo vệ ghi của thẻ SD hoặc bộ nhớ USB.
• Xác nhận xem thuộc tính của tập tin lưu là chỉ được đọc.

584 Advance recipe file save error
Lỗi xảy ra trong khi ghi tập tin công thức. Không được rút thẻ SD hoặc bộ 
nhớ USB ra khi đang vận hành Công thức.

585
Advanced recipe file upload 
error

Lỗi xảy ra trong khi đọc tập tin công thức.
Không được rút thẻ SD hoặc bộ nhớ USB ra khi đang vận hành Công thức.

586
Specified Advanced recipe 
number does not exist.

Công thức của số không tồn tại sắp được thực hiện.
Thực hiện công thức của số đang tồn tại.

587
Specified record number does 
not exist.

Hồ sơ nâng cao của số không tồn tại sắp được thực hiện.
Thực hiện hồ sơ của số đang tồn tại.

588
Cannot save recipe data to read 
only record.

Sắp thực hiện lưu tập tin vào hồ sơ mà giá trị thiết bị công thức không thể 
được chỉnh sửa.
Làm cho giá trị thiết bị công thức của hồ sơ có thể chỉnh sửa với Thiết lập 
Công thức của GT Designer3 hoặc chỉ định hồ sơ mà giá trị thiết bị công 
thức của nó có thể được chỉnh sửa.

589
Recipe device save error. Recipe 
file does not exist.

Sắp thực hiện lưu công thức vào thiết lập công thức mà được cài đặt để 
không sử dụng tập tin.
Chỉ định thiết lập công thức mà sử dụng tập tin.
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590
Recipe device upload error. 
Recipe device value does not 
exist.

Sắp thực hiện tải tập tin vào hồ sơ mà giá trị thiết bị công thức của nó 
không được cài đặt.
Chỉ định hồ sơ mà giá trị thiết bị công thức của nó được cài đặt.

591
Advanced Recipe error. Check 
recipe data.

Thiết lập công thức là không đúng.
Xác nhận thiết lập công thức của dữ liệu project và tài nó vào GOT lần 
nữa.

592
The extension specified to the 
recipe file is invalid.

Kiểm tra nếu tên tập tin thích hợp.
Tên tập tin chứa các ký tự không hợp lệ. Về chi tiết, tham khảo sau đây.
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593
The setting of G1P file of the 
original diversion is different 
from the project data.

Các thiết lập của nguồn khớp với các thiết lập của tập tin công thức nâng 
cao và các phần của tập tin công thức GOT2000, hoặc xoá tập tin công 
thức nâng cao không cần thiết từ thẻ nhớ và tập tin công thức nâng cao 
không khớp với các phần của tập tin công thức GOT2000, hoặc không 
đúng.

595 Logging file error.
Lỗi tập tin ghi lại.
Khi thu thập dữ liệu lần nữa, xoá các tập tin ghi lại và các tập tin quản lý.

596
Logging setting does not exist 
or setting value error.

Thiết lập ghi lại không tồn tại hoặc lỗi giá trị thiết lập.
Chỉ định thiết lập ghi lại đang tồn tại trong thiết lập biểu đồ xu hướng lịch 
sử và thiết lập danh sách dữ liệu lịch sử.

597
The specified logging ID does 
not exist.

•  Chỉ định ID ghi lại đang tồn tại trong thiết bị Điều khiển Ngoài ID Ghi lại.
•  Chọn chức năng offset biểu đồ để chỉ định ID ghi lại đang tồn tại trong 

thiết lập ghi lại.

598
The specified logging setting is 
incompatible.

•  Tạo cấu hình thiết lập để số lượng các biến ghi lại cài đặt cho ID ghi lại 
vượt so với các đường dữ liệu trên biểu đồ xu hướng lịch sử.

•  Tạo cấu hình thiết lập để kiểu dữ liệu của thiết bị ghi lại cài đặt cho ID ghi 
lại giống với biến được chỉ định trong biểu đồ xu hướng lịch sử.

601 Printer unit error.

Thiết bị máy in được cài đặt không đúng. Bộ nhớ flash cài sẵn của đơn vị 
máy in bị hỏng hoặc đã quá tuổi thọ được bảo hành.
Kiểm tra rằng thiết bị máy in được cài đặt đúng.
thiết bị vị máy in đã được cài đặt đúng, bộ nhớ flash cài sẵn bị hỏng hoặc 
đã quá tuổi thọ được bảo hành. Thay thế đơn vị máy in bằng cái mới.

602 Video/RGB unit not mounted
•  Kiểm tra nếu mô đun đầu vào video/RGB được cài đặt.
•  Kiểm tra nếu GOT đã sử dụng các hỗ trợ đầu vào video/RGB.

603 External I/O unit error Kiểm tra nếu mô đun I/O bên ngoài được cài đặt đúng.

604 Sound output unit error Kiểm tra nếu mô đun ngõ ra âm thanh được cài đặt đúng.

605 USB device I/F error
Lỗi có thể bị gây ra do hỏng trong GOT.
Liên hệ văn phòng đại diện Mitsubishi nội địa của bạn.

606
Multimedia processing unit is 
not mounted.

Mô đun đa phương tiện được cài đặt không đúng.
Kiểm tra rằng mô đun đa phương tiện được cài đặt đúng.
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607
Video · RGB input object has 
too many. Please reduce the 
number of settings.

Giảm số lượng các đối tượng hiển thị video/RGB được hiển thị cùng lúc.

608
Hierarchical relationship of 
video · RGB input object can 
not be represented correctly.

Hãy chắc rằng nhiều đối tượng hiển thị video/RGB không chồng chéo lên 
nhau.

610 Insufficient memory capacity.
Dung lượng bộ nhớ cho chức năng giao diện MES không đủ.
Xoá các tập tin không cần thiết, và đặt bộ nhớ.

611
Improper job files. Confirm job 
setting.

Nội dung cho các tập tin công việc không khớp với thiết lập cho các tập 
tin công việc. Kiểm tra nếu có lỗi trong các thiết lập trên màn hình cài đặt.

612
Cannot access Logging Files. 
Check the memory card.

•  Cắm thẻ SD hoặc bộ nhớ USB.
•  Đóng nắp thẻ SD để thẻ SD có thể được truy cập.
•  Nếu thẻ SD hoặc bộ nhớ USB có các tập tin không cần thiết, xoá các tập 

tin đó.

613 Error in writing logfile
•  Cắm thẻ SD hoặc bộ nhớ USB.
•  Đóng nắp thẻ SD để thẻ SD có thể được truy cập.
•  Kiểm tra nếu thẻ SD hoặc bộ nhớ USB có thể ghi được.

614 Error in reading logfile
•  Cắm thẻ SD hoặc bộ nhớ USB.
•  Đóng nắp thẻ SD để thẻ SD có thể được truy cập.
•  Kiểm tra nếu thẻ SD hoặc bộ nhớ USB có thể đọc được.

615
Cannot connect to MES Server.
Check the Server.

•  Máy chủ không hoạt động bình thường hoặc đường dẫn kết nối đến 
máy chủ được hình thành không đúng.

•  Kiểm tra các điều kiện vận hành của máy chủ.
•  Kiểm tra mạng nối đến máy chủ.

616
Cannot connect to SNTP Server.
Check the Server.

•  Các thiết lập cho máy chủ SNTP sai hoặc mạng nối đến máy chủ SNTP 
được hình thành không đúng.

•  Kiểm tra các điều kiện vận hành của máy chủ STNP.
•  Kiểm tra mạng nối đến máy chủ SNTP.

620 Trial connection has started.

Khi số giấy phép của chức năng GOT Mobile chưa được đăng ký, GOT sẽ 
được truy cập bởi các thiết bị thông tin.
Để sử dụng chức năng GOT Mobile trong phiên bản đầy đủ, đăng ký số 
giấy phép trên GOT.

630 Failed to save a video file.
Kiểm tra vùng có sẵn thẻ CF, trạng thái cài đặt, việc xoá bỏ của bảo vệ ghi, 
trạng thái định dạng và số tập tin được lưu.

631
Failed to save a video file on 
network.

Kiểm tra trạng thái kích hoạt của phần mềm liên kết máy tính cá nhân 
trong máy chủ tập tin, thiết lập của chức năng FTP Ethernet trong GOT, 
thiết lập mạng của GOT và máy chủ tập tin và vùng có sẵn của thẻ SD cài 
đặt trong khối chính GOT.



PHỤ LỤC 1-14

Mã lỗi Thông báo lỗi Hoạt động

632
Error detected during 
multimedia processing.

Tắt GOT và kiểm tra trạng thái cài đặt của thiết bị đa phương tiện, hoặc 
thay đổi đơn vị đa phương tiện.

633
The version of the unit software 
is not the latest.

Cài đặt phần mềm thiết bị đa phương tiện tương thích mới nhất sử dụng 
utility của GOT.

634

No space remaining in 
the multimedia CF card. 
Terminating long time 
recording.

Thay đổi thẻ CF cài đặt trên thiết bị đa phương tiện, hoặc xoá các tập tin 
không cần thiết.

640
An error occurred in a FTP client 
process.

Tạo cấu hình lại thiết lập GOT (trình khách FTP).
Kiểm tra trạng thái vận hành và đường mạng của máy chủ FTP.
Về các chi tiết lỗi, kiểm tra GS989 đăng ký đặc biệt GOT (thông báo lỗi 
giao tiếp FTP).
→ GT Designer3 (GOT2000) Screen Design Manual

641
The license key has not been 
registered. Confirm your 
license.

Trên GOT, đăng ký số giấy phép cho chức năng máy chủ VNC, chức năng 
vận hành máy tính cá nhân từ xa (Ethernet), chức năng giao diện MES, 
hoặc chức năng GOT Mobile.

650
The operator management 
information file is invalid.

Chuẩn bị tập tin thông tin quản lý người vận hành bình thường và nhập 
vào, hoặc lưu trữ tập tin thông tin quản lý người vận hành tại địa điểm chỉ 
định.

651
Cannot access the operator 
management information file.

Kiểm tra nếu ổ đĩa đích mà lưu trữ tập tin thông tin quản lý người vận 
hành chỉ định có thể được truy cập bởi GOT.

660
Failed to obtain op. authority. 
Server does not respond.

Hãy chắc rằng GOT chủ đã được kết nối và khởi động.
Hãy chắc rằng chức năng tương tác mạng GOT được phép trong GOT chủ.

670
Current alarms exceeded the 
max no. that can be procd. at a 
time.

Có một trăm hoặc hơn báo động hệ thống đã xảy ra cùng lúc.
Loại nguyên nhân của báo động hệ thống ngõ ra và kiểm tra báo động hệ 
thống lần nữa.

697
Package writing of the old 
version is not allowed.

Cài đặt phiên bản mới nhất của GT Designer3, và sau đó thực hiện thao 
tác lần nữa.

698 Insufficient CoreOS version. Cài đặt phiên bản mới nhất của CoreOS.

699 Insufficient BootOS version. Cài đặt phiên bản mới nhất của BootOS.

800 Abnormal module status

Tham khảo các giải thích về SB0020 trên hướng dẫn về mạng có thể ứng 
dụng.
Đối với Mạng theo vùng IE CC-Link, tham khảo hướng dẫn về mô đun 
chủ/cục bộ Mạng theo vùng IE CC-Link MELSEC-Q.

801 Abnormal baton passing status
Tham khảo các giải thích về SB0047 trên hướng dẫn về mạng có thể ứng 
dụng.

802
Abnormal cyclic transmission 
status

Tham khảo các giải thích về SB0049 trên hướng dẫn về mạng có thể ứng 
dụng.
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803 Transient error
Tham khảo các giải thích về SB00EE trên hướng dẫn về mạng có thể ứng 
dụng.

804
The cable on the IN side 
is disconnected or is not 
connected.

Tham khảo các giải thích về SB0067 trên hướng dẫn về mạng có thể ứng 
dụng.

805
The cable on the OUT side 
is disconnected or is not 
connected.

Tham khảo các giải thích về SB0068 trên hướng dẫn về mạng có thể ứng 
dụng.

840 PROFIBUS master is not started. Bật PROFIBUS chủ.

841
I/O setting of the PROFIBUS 
master and slaves do not 
match.

•  Sử dụng tập tin GSD, một tập tin cấu hình cung cấp bởi MITSUBISHI. (Bị 
cấm chỉnh sửa)

• Sửa lại các thiết lập có liên quan, và tắt rồi mở GOT.

850 CC-Link switch setting error

• Kiểm tra nếu các thiết lập công tắc không có lỗi.
•  Kiểm tra các mã lỗi lưu trữ trong SW006A.
•  Tham khảo các giải thích về SB006A trên hướng dẫn về mạng có thể ứng 

dụng.

851
Abnormal cyclic transmission 
status

•  Kiểm tra nếu các điện trở khoá được kết nối.
•  Kiểm tra các mã lỗi cho PLC CPU.
•  Kiểm tra thông số cho PLC CPU trên trạm chính.
•  Kiểm tra trạng thái lỗi của trạm chính.
•  Tham khảo các giải thích về SB006E trên hướng dẫn về mạng có thể ứng 

dụng.

852 Abnormal host line status
•  Kiểm tra cáp có bị tháo hay không.
•  Tham khảo các giải thích về SB0090 trên hướng dẫn về mạng có thể ứng 

dụng.

853 Transient error
•  Kiểm tra trạng thái xảy ra lỗi nhất thời cho mỗi trạm lưu trữ trong 

SW0094 đến SW0097.
•  Tham khảo các giải thích về SB0094.

860
Off line or the network power is 
off.

• Kiểm tra đồng hồ chỉ thị LED trạng thái mô đun.
• Bật mạng lên.
• Kiểm tra xem các cáp được kết nối đúng.
•  Làm phù hợp tốc độ giao tiếp của GOT với thiết bị chính.

861 No connections are established.
• Kiểm tra các thiết lập của thiết bị chính.
• Bật thiết bị chính.

862 Critical link error
Bộ điều khiển hỏng, hoặc có lỗi làm vô hiệu liên lạc mạng. (MAC IDs bị 
trùng lặp, hoặc Bus-off được phát hiện.) Kiểm tra bộ điều khiển.

863 Incomplete configuration
Thiết lập bộ điều khiển không được cấu hình, hoặc thiết lập không tương 
xứng hoặc không đúng.
Xem lại thiết lập bộ điều khiển.
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Mã lỗi Thông báo lỗi Hoạt động

864 Unrecoverable fault(s) Bộ điều khiển có lỗi không thể sửa được.

865 Recoverable fault(s)
Lỗi được sửa tự động.
Nếu đồng hồ chỉ thị LED trạng thái mô đun không chuyển màu xanh, bộ 
điều khiển có thể bị hỏng.
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Cài đặt GOT với sự cân nhắc về kích thước bên trong bảng điều khiển và khu vực bị cấm cài đặt.
Tuỳ thuộc các loại cáp kết nối được nối với GOT, có thể sẽ cần khoảng cách nhiều hơn kích thước được mô tả.
Cài đặt GOT với sự cân nhắc về kích thước đầu nối và bán kính cong cáp.

2 Cắt bảng pa nen
 ● GT2715-X

Mở lỗ cài đặt trên bảng điều khiển với kích thước như hình bên dưới.

A

B

CC

C
C

A

B

C
C

CC

Ngang Dọc
Đơn vị: mm

Mẫu A B C Độ dày bảng

GT2715-X
383,5
(+2, 0)

282,5
(+2, 0)

10 hoặc Hơn 1,6 đến 4

Kích thước C cho thấy các phép đo đối với phụ kiện được lắp ráp trên bảng điều khiển.

PHỤ LỤC 2 CÀI ĐẶT VÀ THÁO
1 Biện pháp phòng ngừa khi cài đặt



PHỤ LỤC 2-2

 ● GT2712-S, GT2710-S, GT2710-V, GT2708-S, GT2708-V, GT2705-V
Mở lỗ cài đặt trên bảng điều khiển với kích thước như hình bên dưới.

A

B
C

C

A

BC C

Ngang Dọc
Đơn vị: mm

Mẫu A B C Độ dày bảng

GT2712-S
302

(+2, 0)

228

(+2, 0)

10 hoặc Hơn 1,6 đến 4

GT2710-S, GT2710-V
289

(+2, 0)

200

(+2, 0)

GT2708-S, GT2708-V
227

(+2, 0)

176

(+2, 0)

GT2705-V
153

(+2, 0)

121

(+2, 0)

Kích thước C cho thấy các phép đo đối với phụ kiện được lắp ráp trên bảng điều khiển.
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3 Vị trí cài đặt

Để cài đặt GOT, cần phải có khoảng cách giữa GOT và các thiết bị khác.

 ● GT27
Tuỳ thuộc vào các thiết bị và cáp dùng cho GOT, có thể sẽ cần khoảng cách nhiều hơn kích thước được mô tả.
Cài đặt GOT với sự cân nhắc về kích thước đầu nối và bán kính cong cáp.
Đối với khoảng cách kéo cáp từ đáy GOT, tham khảo sau đây.
→ GOT2000 Series User’s Manual (Hardware)
Đối với cài đặt theo chiều dọc, cài GOT sao cho mũi tên cài đặt theo chiều dọc được in trên các điểm lưu ý mặt sau 
GOT hướng lên.
→ GOT2000 Series User’s Manual (Hardware)

B

ED

A

C

Độ dày bảng: 1,6 đến 4

Đơn vị: mm

Ngang

B

D

E
A

C

Dọc Độ dày bảng: 1,6 đến 4

Đơn vị: mm

Các bảng sau đây liệt kê ra khoảng cách cần có giữa GOT và các thiết bị khác.
Áp dụng kích thước trong ngoặc đơn khi không có thiết bị phát sinh ra tiếng ồn (như công tắc tơ) hoặc nhiệt được 
lắp đặt cần GOT.
Tuy nhiên, luôn giữ nhiệt độ xung quanh GOT đến 55°C hoặc thấp hơn.
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Đơn vị: mm

Mục

GT27

GT2715-X GT2712-S
GT2710-S, 

GT2710-V

GT2708-S, 

GT2708-V
GT2705-V

A

Chỉ có GOT
48 hoặc hơn

[18 hoặc hơn]

48 hoặc hơn 

[29 hoặc hơn]
59 hoặc hơn

Đơn vị kết nối tuyến 

được lắp

48 hoặc hơn

[18 hoặc hơn]

23 hoặc hơn 

[29 hoặc hơn]
48 hoặc hơn

Đơn vị kết nối theo 

chuỗi được lắp

48 hoặc hơn

[18 hoặc hơn]
47 hoặc hơn

Đơn vị truyền thông CC-

Link (GT15-J61BT13) đã 

lắp

48 hoặc hơn

[18 hoặc hơn]

50 hoặc hơn  

[22 hoặc hơn]

Đơn vị truyền thông 

MELSECNET/H (đồng 

trục) đã lắp*1

48 hoặc hơn

[18 hoặc hơn]

48 hoặc hơn 

[38 hoặc hơn]

48 hoặc hơn 

[45 hoặc hơn]
67 hoặc hơn 81 hoặc hơn

Đơn vị truyền thông 

MELSECNET/H

(quang học) đã lắp*2

48 hoặc hơn

[18 hoặc hơn]
77 hoặc hơn

Đơn vị truyền thông 

Mạng Bộ điều khiển IE 

CC-Link đã lắp

48 hoặc hơn

[18 hoặc hơn]
55 hoặc hơn

Đơn vị truyền thông 

Mạng theo vùng IE CC-

Link đã lắp

48 hoặc hơn

[18 hoặc hơn]
55 hoặc hơn

Đơn vị đầu vào video đã 

lắp*1

48 hoặc hơn

[18 hoặc hơn]

48 hoặc hơn 

[38 hoặc hơn]

48 hoặc hơn 

[45 hoặc hơn]
67 hoặc hơn -

Đơn vị đầu vào RGB đã 

lắp*3

48 hoặc hơn

[18 hoặc hơn]
-

Đơn vị đầu vào video/

RGB đã lắp*1*3 

48 hoặc hơn

[18 hoặc hơn]

48 hoặc hơn 

[38 hoặc hơn]

48 hoặc hơn 

[45 hoặc hơn]
67 hoặc hơn -

Đơn vị ngõ ra RGB đã 

lắp*3

48 hoặc hơn

[18 hoặc hơn]
-

Đơn vị đa phương tiện 

đã lắp*1

48 hoặc hơn

[18 hoặc hơn]

48 hoặc hơn 

[38 hoặc hơn]

48 hoặc hơn 

[45 hoặc hơn]
67 hoặc hơn -

Đơn vị máy in đã lắp
48 hoặc hơn

[18 hoặc hơn]

Đơn vị I/O bên ngoài đã 

lắp

48 hoặc hơn

[18 hoặc hơn]

Đơn vị ngõ ra âm thanh 

đã lắp

48 hoặc hơn

[18 hoặc hơn]

B
Ngang: 78 hoặc hơn [18 hoặc hơn]

Dọc: 48 hoặc hơn [18 hoặc hơn]
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Đơn vị: mm

Mục

GT27

GT2715-X GT2712-S
GT2710-S, 

GT2710-V

GT2708-S, 

GT2708-V
GT2705-V

C

Khi thẻ SD được dùng
50 hoặc hơn

[20 hoặc hơn]
50 hoặc hơn 100 hoặc hơn

Khi thẻ SD không được 

dùng

50 hoặc hơn

[20 hoặc hơn]

D
Ngang: 50 hoặc hơn [20 hoặc hơn]

Dọc: 80 hoặc hơn [20 hoặc hơn]

E*4
100 hoặc hơn

[20 hoặc hơn]

*1 Giá trị này để dùng cho cáp đồng trục 3C-2V (JIS C 3501). 
Đối với thông số kỹ thuật của cáp, tham khảo GOT2000 Series Connection Manual cho bộ điều khiển được sử 
dụng.

*2 Giá trị này khác nhau tuỳ thuộc cáp được sử dụng.
*3 Giá trị này khác nhau tuỳ thuộc cáp được sử dụng. 

Nếu bán kính cong của cáp được sử dụng lớn hơn giá trị được chỉ định trên, áp dụng giá trị của cáp được sử 
dụng.

*4 Khi mở hoặc đóng nắp pin: 72 hoặc hơn
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 ● GT27
Cài đặt GOT với phần hiển thị được bố trí như hình bên dưới.
Sử dụng GOT với góc cài đặt khác với hướng dẫn sau sẽ gia tăng độ hư hỏng của GOT.

Khi mô đun đa phương tiện (GT27-MMR-Z), mô đun truyền thông MELSECNET/H (GT15-J71LP23-25, GT15-J71BR13), 
hoặc mô đun truyền thông CC-Link (GT15-J61BT13) được gắn, nhiệt độ xung quanh khi vận hành phải thấp hơn 5°C 
so với nhiệt độ tối đa 55°C chỉ định trong thông số kỹ thuật chung.

(1) Cài đặt GOT theo chiều ngang
Khi GOT được cài đặt trong bất cứ góc từ 60° đến 105°, nhiệt độ bên trong bảng điều khiển phải trong khoảng 
55°C.
Khi GOT được cài đặt trong bất cứ góc ngoài phạm vi từ 60° đến 105°, nhiệt độ bên trong bảng điều khiển phải 
trong khoảng 40°C.

GOT

Hiển thị 
phần

Bảng điều khiển 
hoặc những cái khác

105°

60°

(2) Cài đặt GOT theo chiều dọc
Khi GOT được cài đặt một góc 90°, nhiệt độ bên trong bảng điều khiển phải trong khoảng 55°C.
Khi GOT được cài đặt trong bất cứ góc khác với 90°, nhiệt độ bên trong bảng điều khiển phải trong khoảng 40°C.

GOT

Hiển thị 
phần

Bảng điều khiển 
hoặc những cái khác

90°

4 Nhiệt độ bên trong bảng điều khiển và Góc cài đặt GOT
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5 Cài đặt GOT

 ● GT27

Bảng đang mở

GOT
1 Ráp mặt sau GOT vào khung hở của bảng.

 ● Đối với GT2715-X (8 phụ kiện) 2 Khi đặt phụ kiện vào lỗ lắp trên GOT, vặn ốc 
trong phạm vi mô men xoắn được chỉ định 
(0,36 Nm đến 0,48 Nm).
Vặn ốc với mô men xoắn vượt quá phạm vi mô 
men xoắn được chỉ định có thể làm biến dạng 
bảng trước GOT, dẫn đến tấm bảo vệ bị nhăn.

 ● Đối với GT27 ngoại trừ GT2715 -X (4 phụ kiện)

3 Bỏ màng bảo vệ khỏi GOT.
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6 Tháo GOT

 ● GT27
 ● Đối với GT2715-X (8 phụ kiện)

1 Tháo ốc ra khỏi GOT.
Tháo phụ kiện ra khỏi GOT.

 ● Đối với GT27 ngoại trừ GT2715-X (4 phụ kiện)

Bảng đang mở

GOT
2 Tháo GOT ra khỏi khung hở của bảng.
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7 Lắp/Tháo thẻ SD

Quy trình lắp thẻ SD được đưa ra dưới đây.

 ● GT27

(a) 

1 Mở nắp thẻ SD như hình bên trái.
(Phía sau GOT được đặt hướng lên trên như 
trong hình minh hoạ)

Mở nắp của 
giao diện thẻ SD 
90 độ hoặc hơn.

Đèn LED báo hiệu 
đang truy cập thẻ 
SD

2 Sau khi chắc rằng ĐÈN truy cập thẻ SD tắt khi 
nắp thẻ SD mở 90 độ hoặc hơn, lắp thẻ SD vào 
với mặt trước hướng lên.

3 Đẩy và đóng nắp thẻ SD cho đến khi vào khớp.

4 Khi nắp thẻ SD được đóng, cho phép truy cập 
vào thẻ SD.
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Quy trình tháo thẻ SD được đưa ra dưới đây.

 ● GT27

(a) 

1 Mở nắp thẻ SD như hình bên trái.

Mở nắp của 
giao diện thẻ SD 
90 độ hoặc hơn.

Đèn LED báo hiệu 
đang truy cập thẻ 
SD

2 Sau khi chắc rằng ĐÈN truy cập thẻ SD tắt khi 
nắp thẻ SD mở 90 độ hoặc hơn, đẩy thẻ SD vào 
để tháo thẻ ra.

3 Đóng nắp mặt trong thẻ SD.
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8 Đấu dây cung cấp điện cho GOT

Đoạn sau cho thấy các ví dụ về đấu dây cáp điện, cáp tiếp đất và các cáp khác vào thiết bị đầu cuối cung cấp điện cho 
GOT.

 ● GT27

ĐẦU VÀO
100-240 V AC

GOT

ĐẦU VÀO
24 V DC

Cầu chì
Đối với 100 V AC

+-

Cáp tiếp đất
Nối đất

Dành cho 24 V DC
GOT

+-

ĐẦU VÀO
24 V DC

Dành cho 24 V DC (GT2705)
GOT

 ~ Biện pháp phòng ngừa (GT27)

(1) Cách xử lý cáp nguồn
Đối với cáp 200 V AC và 24 V DC, sử dụng dây điện dày càng nhiều càng tốt (Mặt cắt ngang cáp: 0,75 tới 2 mm2), và 
chắc rằng xoắn chúng cho đến các thiết bị đầu cuối.
Để tránh đoản mạch vì ốc lỏng, sử dụng thiết bị đầu cuối không hàn với ống cách điện.

(2) Nối đất
Sau khi kết nối chân LG và chân FG, hãy đảm bảo chúng được tiếp địa.
Nếu không, hệ thống sẽ dễ nhiễu.
Chân LG có điện thế bằng một nửa điện áp đầu vào.
Vì thế, chạm vào thiết bị đầu cuối có thể dẫn đến điện giật.
Đối với GT2705-V, kết nối chỉ chân FG vì dòng này không có chân LGG.

Về chi tiết cách xử lý cáp nguồn và nối đất, xem hướng dẫn sau đây.
→GOT2000 Series User’s Manual (Hardware)
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Màn hình cảm ứng có thể được hiệu chỉnh.
Thông thường, không cần phải chỉnh sửa, tuy nhiên sau một thời gian dài sử dụng vị trí chạm và vị trí đối tượng có thể 
khác nhau nhiều.
Khi có sự khác nhau xảy ra giữa vị trí chạm và vị trí đối tượng, chỉnh lại vị trí cho đúng bằng chức năng này.

Run RunStop Stop

Trước khi điều chỉnh Sau khi điều chỉnh

[Run] sẽ vận hành thông qua bạn
đã định chạm vào nút [Stop].

Có thể chạm vào nút [Stop]
mà không thất bại.

(1) Trình tự để chỉnh sửa hệ toạ độ màn hình cảm ứng

1

1 Chạm vào [Utility call key].

2

2 Chạm vào [Touch panel calibration] trên màn 
hình [Maintenance] trong [Utility main menu].

PHỤ LỤC 3 HIỆU CHỈNH MÀN HÌNH CẢM ỨNG
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3 Chạm chính xác vào trung tâm của  được 
hiển thị ở phía trên, bên trái.

4 Chạm vào điểm  được hiển thị ở phía trên, 
bên phải.

5 Chạm vào điểm  được hiển thị ở phía dưới, 
bên trái.
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6 Chạm vào điểm  được hiển thị ở phía dưới, 
bên phải.

7 Chạm vào nút  được hiển thị ở phía trên, bên 
phải, để quay trở về màn hình trước.
Khi thao tác chạm không được chính xác, hãy 
chạm vào nút [Readjustment] để thiết lập lại từ 
3  một lần nữa.
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PHỤ LỤC 4 SÁCH HƯỚNG DẪN SỬ DỤNG VÀ 

CATALÔ CÓ LIÊN QUAN
Catalô sê-ri GOT2000

Tên catalô Mã số catalô

Graphic Operation Terminal GOT2000 Series L(NA)08270ENG

Graphic Operation Terminal Screen Design Software MELSOFT GT Works3 L(NA)08170ENG

Sách hướng dẫn sử dụng liên quan đến sê-ri GOT2000

Tên sách hướng dẫn sử dụng
Mã số sách hướng dẫn sử 

dụng

GOT2000 Series User’s Manual (Hardware) SH-081194ENG

GOT2000 Series User’s Manual (Utility) SH-081195ENG

GOT2000 Series User’s Manual (Monitor) SH-081196ENG

GOT2000 Series Connection Manual (Mitsubishi Products) For GT Works3 Version1 SH-081197ENG
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PHỤ LỤC 5 LẮP RÁP THIẾT BỊ THỰC TẬP

Phần phụ lục này mô tả thông số kỹ thuật và phương pháp kết nối của thiết bị thực tập được sử dụng trong “Satellite 
Training System Part 3: GOT”.

Thiết lập cấu hình thiết bị
● Át tô mát: NF30-FA (2 P, 10 A) của Mitsubishi Electric Corporation

● Bộ điều khiển có thể lập trình: MELSEC iQ-R của Mitsubishi Electric Corporation

● Graphic operation terminal: GT2708-STBA của Mitsubishi Electric Corporation

● Công tắc dừng khẩn cấp

Sơ đồ kết nối thiết bị thực tập

Át tô mát
NF30-FA (Mitsubishi Electric Corporation)

Nguồn điện AC một pha
200 V AC

L N

2 4

1 3

ĐẦU VÀO AC

ĐẦU VÀO AC

Nối đất

Graphic operation terminal
GT2708-STBA 
(Mitsubishi Electric Corporation)

Bộ điều khiển lập trình
MELSEC iQ-R
(Mitsubishi Electric Corporation)

Cáp Ethernet

Cáp USB

Máy tính cá nhân

L1 N1
→

Công tắc 
stop khẩn cấp

24 V DC 
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PHỤ LỤC

Trình tự kết nối thiết bị thực tập
1. Đấu dây cáp nguồn điện (200 V AC) vào đầu vào của át tô mát.
2.  Đấu dây cấp nguồn của PLC và GOT vào đầu ra của máy ngắt mạch không có cầu chì.
3. Đấu dây công tắc dừng khẩn cấp.
4. Kết nối máy tính cá nhân và GOT bằng dây cáp USB.
5. Kết nối GOT và PLC bằng cáp Ethernet.

Về thiết lập giao tiếp giữa máy tính cá nhân và GOT, hãy tham khảo “2.1.1 Kết nối máy tính cá nhân với GOT” trong văn 
bản này.
Về thiết lập giao tiếp giữa GOT và PLC, hãy tham khảo “2.2.1 Kết nối GOT và PLC” trong văn bản này.



Thương hiệu và thương hiệu đã được đăng ký
Sản phẩm và tên công ty đều là thương hiệu hoặc thương hiệu đã được đăng ký của chủ sở hữu.

Màu sắc thực tế có thể có chút khác biệt so với ảnh trong catalô này.
Hiển thị thực tế có thể sẽ khác so với những gì được biểu thị trên ảnh về màn hình GOT.
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Graphic Operation Terminal
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